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THE PENCIL “PROBLEM”

A WARM WELCOME this issue to our new
Production Editor, Rachel, who joins us
from sister titles 3D World and
ImagineFX. Rachel has been at Future for
six years and, naturally, jumped at the
opportunity to work on a prestigious title
like Mac/Life! The chance to check out all
the latest and greatest Apple gear might
have also been a contributing factor.

As you’ve probably already seen from
this month’s cover, Apple recently
launched two new iPads: the iPad Pro
12.9—inch which is now rocking an M2
chip — nice, but not a huge deal overall;
and the eminently more interesting
“entry-level” iPad, which now sports a 10.9-inch screen, new
colors and a bit more horsepower under the hood. Owners of the
iPad Air (5th gen) would be forgiven for struggling to discern a
difference between the two tablets; aside from the chip and price
tag, they’re basically identical. Oh, did we forget to mention the
elephant in the room that is the Apple Pencil problem?

This is where things get interesting — whereas the iPad Air
uses the latest Apple Pencil (2nd gen) as you would expect of a
modern iPad, the new iPad (10th gen) does a strange about—-face
tech devolution and only works with the Apple Pencil (1st gen).
What that means is you don’t get the 2nd gen’s ability to charge
wirelessly, but what’s worse is because the new iPad has moved to
the USB-C standard to match with the rest of the iPad lineup
(finally), and the original Apple Pencil uses a Lightning connector,
you need to use an adapter, which is just, well, weird. Oh, and if
you have the original Apple Pencil you’ll need to buy said adapter
just to charge the damn thing with the new iPad (another S9,
thank you). You can just imagine the outcry from fans on the
internet. Suffice to say, the news didn’t go down well.

That’s the thing with Apple — sometimes there’s the Apple of
old, with brilliant innovation or just some cool new trick (like
Dynamic Island), and then at other times it makes very odd design
decisions which seemingly only serve to upset its loyal customers.

ek

NICK ODANTZIS, Editor

Twitter: @maclife

Editor’s opinion

@ THE TEAM

Matt Lochrie

Art Editor

Matt has made subtle
design changes to the
mag that, unlike Apple’s,
actually work really well...

Rachel Terzian
Production Editor
Rachel is very excited to
join the team at Mac|Life
and upgrade her Apple
know-how even further.

George Cairns
Contributor

George shows how to put
your photos on anything,
from coffee cups to cell
phone cases! (p26.)
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iPadOS 16: Tips, tricks

& secrets

Get to grips with this huge upgrade and
discover its advances in collaboration,
security, multitasking, and much more.

4 | JAN 2023

Contents:

Print your photos

Learn how to produce high-quality
prints and unique products from your
digital photos, and restore your old
analog prints to their former glory.
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Get started with: Purchases
and subscriptions

We explore how to efficiently manage
your entertainment subscriptions in
this extensive, easy-to-follow guide.

Image rights: Apple Inc, Getty.
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THE LATEST NEWS FROM THE WORLD OF APPLE

Apple TV 4K

updated

Home entertainment
hub — now with a bit
more “oomph”

BY ALEX SUMMERSBY

APPLE HAS RELEASED a next-
generation Apple TV 4K. There’s

a $129 Wi-Fi model with 64GB of
storage, and a S149 Wi-Fi+Ethernet
model with 128GB storage, Gigabit
Ethernet connectivity, and Thread
mesh networking to connect to more
smart home accessories. App and
streaming service subscriptions are
not included, although Apple is
currently offering three months of
Apple TV+ and Apple Arcade for free
when you buy the hardware and have
not previously taken up a free trial.

The A15 Bionic chip in both models
delivers CPU performance up to 50%
faster than the previous generation,
promising greater responsiveness
and faster navigation. GPU
performance is up to 30% faster for
even smoother gameplay.

Both models now support HDR10+
alongside Dolby Vision, although
relatively few TVs currently have
support for HDR10+ built in, and not
much content is currently released
incorporating the dynamic metadata
required by the standard to optimize
the picture scene by scene. With
suitable hardware and content, you
can also enjoy Dolby Atmos, Dolby

6 | 3aN 2023

Digital 7.1, or Dolby Digital 5.1

surround sound for immersive audio.

The Siri Remote (which now plugs
in over USB-C) has a touch—enabled
clickpad for fast and fluid navigation
through the simplified on-screen
interface of Apple TV. It has a
dedicated Siri button on the side for
voice control, and a tvOS upgrade
coming later this year will add Siri
voice recognition for up to six family
members, enabling it to switch
profiles, play individuals’ playlists,
and offer personalized viewing
recommendations on request.

Apple TV 4K is designed to sit at
the heart of your Apple device
ecosystem. It enables you to color
calibrate your TV using your iPhone
camera, and Audio Sharing lets you
connect up to two sets of AirPods
with separate volume control for
each. It supports SharePlay, so you
can add Apple TV to FaceTime calls
on iPhone or iPad to watch with

| -

others on the big screen. Everyone’s
playback remains coordinated, and
shared playback controls mean
anyone in the SharePlay session can
play, pause, or jump ahead.

Apple TV 4K works seamlessly
with HomeKit—enabled accessories
as a smart home hub, so you can
keep track of all your connected
accessories in one place with Control
Center. If you have a supported
iCloud+ plan, HomeKit Secure Video
uses the on—device intelligence of
Apple TV 4K to privately analyze the
video feed from a connected security
camera to detect people, animals,
cars, and package deliveries. You can
connect more devices across more
platforms than ever with Matter,
the new Apple—-backed smart home
connectivity standard. And with
remote access, you can also control
your smart home from the Home app
on your other Apple devices
wherever you go.

Image rights: Apple Inc.



> Twitter changes ahead

What's expected from new chief Elon Musk?

HOW MIGHT TWITTER change
following its acquisition by the world’s
wealthiest individual, Elon Musk?

Several senior executives have left,
including CEO Parag Agrawal, CFO
Ned Segal, and chairman of the board
Bret Taylor, among others, but culls of
management are standard in such
takeovers. It is unknown whether there
will be wider layoffs, although sources
close to Musk say he may axe “projects
that aren't going anywhere.”

The acquisition cost Musk $S44bn,
$13bn of which is a debt that Twitter
will now need to service, so it needs to
turn its finances around. The company
currently reports “negative cashflow” of
more than $120m, and has only about
240m accounts active daily, compared
with nearly two billion on Facebook. So
Musk needs it to grow fast, increase
revenues, cut costs, or all three.

Musk has spoken about expanding
the platform in new directions, or even
making Twitter “the app for everything”
— possibly along the lines of Chinese
app WeChat, which covers a whole raft
of services including messaging, social
media, mobile payments, and food
orders. With over 1.2bn monthly active
users, it is the world's most widely used
single app.

It would require plenty of money and
tech expertise to develop Twitter into
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such an app. In the shorter term, Musk
said he wants to cull fake accounts and
make Twitter more open. Describing
himself as a “free-speech absolutist,”
he has argued for less moderation, as
well as the reinstatement of banned
accounts, such as that of former US
President Donald Trump.

However, advertisers have become
uneasy about their ads appearing
next to unregulated hate speech or
misinformation, and more than 20% of
Twitter's revenue currently comes from
advertising. General Motors, the largest
auto maker in the US, suspended its
advertising on the platform while it
assesses the direction of travel.

Musk moved quickly to reassure
nervous advertisers, saying “Twitter
obviously cannot become a free-for-all
hellscape, where anything can be said
with no consequences.” He announced
that Twitter is establishing a content
moderation council including “widely
diverse viewpoints,” and “no major
content decisions or account
reinstatements will happen before
that council convenes.”

Finally, any reforms will face an
array of regulatory hurdles. “The bird
is free,” Musk tweeted, announcing the
acquisition. EU digital commissioner
Thierry Breton pointedly responded: “In
Europe, the bird will fly by our rules.”

o o.

The latest news from the world of Apple

News in
brief

A bite of the Apple

>iCLOUD.COM REVAMPED

The iCloud.com website has been
redesigned with widget-like tiles. On
the site, currently in beta, you can
now choose which apps are on the
home page, and some have a new,
streamlined design.

> DUCKDUCKGO FOR MAC

The public beta of DuckDuckGo for
Mac is available for download. Its core
feature is private search that blocks
hidden trackers, so you see what
you're after and not endless ads for
what you searched for yesterday. The
app includes web and app tracking
protection, Smarter Encryption, voice
search and more, with platform-
specific features for i0OS, Android,
Firefox, Chrome, Edge, and Safari.
The Burn After Reading feature clears
your tabs and browsing data with a
very satisfying flame animation.

> FIRST METAL 3 GAME RELEASED
Resident Evil Village, the first title to
use Apple’s new Metal 3 graphics
framework for games, is available
now in the Mac App Store. The Metal
API enables developers to take
advantage of hardware-accelerated
graphics, and Metal 3's new features
help apps tap into the potential of
Apple silicon with high-performance
upscaling, faster resource loading,
offline shader compilation, new ray
tracing features, and other advances.

JAN 2023



> THE SHIFT

MATT BOLTON l|oves the new Apple Watch
SE so much that it makes him wonder if the
pricier watches have become stagnant

VER THE LAST few weeks, I
have been testing out the
new Apple Watch SE. My
review can pretty much be
summed up as: it feels like such a

Not everyone loves the
Hermes Apple Watches,
but maybe they don't go
far enough with
customizing
the look...

reproductive tracking. But
those people are not me.

But also note how much
time even those features have
accumulated over... the ECG

premium Apple Watch experience
overall that I switched to it from
the Apple Watch Series 7, and I
didn’t feel any major loss. I barely
noticed it was a different device,
other than the fact that it was even
lighter and didn’t have an
always—on screen.

And then I switched to testing
the Apple Watch Series 8, and it
didn’t really feel any different
compared to using the cheaper
Watch. I liked having the always-
on screen back, yes, but overall it

IT SEEMS LIKE THE

APPLE WATCH
“SERIES” MODELS

ARE STUCK IN A RUT

appeared on the Series 4,
always—on on the Series 5, the
pulse oximeter on the Series 6, the
screen on the Series 7, temperature
on the Series 8. Four years of
features built up to separate the
expensive Watch from the cheaper
one, and I just... don’t mind losing
them all? I can’t help but feel that
the only reason the Apple Watch
SE didn’t get the always—on screen
this time is that Apple knows that
no one would pay for the expensive
one if the cheap option had it.

It seems like the Apple
Watch “Series” models are
stuck in a rut. The SE delivers
95% of the experience for less;
the Apple Watch Ultra pushes
things in exciting new
directions. But in the middle?
It feels tough. And it’s not like

feels like a bit of an anticlimax. For
S150 more, you get changes you
barely notice. Some people will
make more use of the extra
millimeter of screen and the
QWERTY keyboard it permits, the
ECG, the pulse—-oxygen sensor, or
the temperature sensor for

[ have some genius plan where

[ point to an obvious upgrade
and go “Why doesn’t Apple just
add that to make it interesting
again?” We’re already at a point
where you have to ask what
additions would benefit the Apple
Watch. Should Apple go with a
round face or get rid of the Digital
Crown for the sake of change?

I think for a lot of people, the
biggest selling point of the Series 8
will be that it comes in stainless
steel. That’s something people
want from a Watch, and they can
only get it there. So I wonder if
Apple needs to lean further into
that. The Series 8 not only needs
more materials, but more options
in those materials. Colors that
rotate with the seasons like it does
for bands; patterns designed by
artists in limited runs; different
textures and finishes.

But it could be functional design
too: if the Series 9 was just like the
Series 8 but notably thinner, that
too would make it stand out from
the Watch SE. Given the status of
a watch as a kind of jewelry, I think
the Apple Watch would do just fine
if the Series watches leaned even

| more into aesthetics.

>>> Matt is Senior Editor at Future’s flagship technology website TechRadar and has been charting changes at Apple since
his student days. He's skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing.”
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LETTER OF THE MONTH

A while ago my son was traveling
on a bus and received unsolicited
graphic images — someone had
sent them to him via AirDrop. He
was really upset and it’s had a big
impact on his well-being. How do
I stop this from happening in
future? I am surprised that his
iPhone is able to receive content
from anyone who’s nearby on
another iPhone. It’s very
irresponsible of Apple.

ANON

By default, AirDrop on an iPhone
should be set to only receive content
from contacts, so you would have to
manually set it to receive from
everyone. This is an easy thing to do
— we’ve been guilty of changing
this ourselves and later forgetting to

turn it back to a more secure
setting, so it’s understandable that
this can happen.
Unfortunately, cases of
“cyberflashing” or sharing
explicit content via AirDrop
has become more prolific in
recent years (it’s been documented
for well over five years now, so it’s
not new) due to the increase in
people who own an iPhone and use
the service for sharing media.
AirDrop is very handy, provided
it’s used with some caution, so be
sure to check your settings
regularly, to make sure you’re not at
risk of being sent unsolicited
content. In Settings > General >
AirDrop, ensure Contacts Only is
checked, or if you want to be really
careful, set this to Receiving Off.

assumes that you want to
project the photo or video that's
been selected, and not the entire
screen so you can show the
class the icons for the tools
available to use with that photo. |
hate this. If | want to see (and
project) the entire photo or
video, | can do that by tapping
on it again. | don't want that to
be the mode it automatically
goes into when | do screen

Projecting photos
Okay, here’s a tricky one for you. |
regularly teach people how to
use their iPhones and iPads with
a big screen projection unit to
mirror either my device or theirs.
It works perfectly for things like
Safari, Mail, and other apps. But
where it frustrates me is Photos.
In the Photos app, it always

mirroring or connect an HDM|
cable to it. Is there a way around
this? Thanks.

FIONA O'MALLEY-DEVITO

Both the editor and our
resident tech expert Howard
were unable to find a
workaround for this —
unfortunately it seems that

Commentary for consideration

your requirement may well be
just a little bit too niche forit
to be something that can be
easily adjusted in the settings.
We're pretty sure that most
people out there would be
happy enough to just mirror
their photos on a big screen
without needing to see the i0S
settings at the same time. All
that being said, if anyone
knows of an easy way of
getting around this, then do
getin touch.

GarageBand woes
Greetings gentlefolk, here is
something for you to check out. |
have an iPad Pro 9.7-inch that's
running the latest version of
iPadOS (15, that is). | tried to
open GarageBand recently, only
to discover that | could not do
so. Further investigation led me
to the App Store. There | was
informed that the currently
installed version of GarageBand
requires iPad0S 16 in order to
function! As | am sure you are
aware, iPad0S 16 is not yet
available (at the time of writing). |
was given the choice to
download the previous version of
GarageBand. This strikes me as a
rather peculiar situation. |
suspect that some users of
GarageBand, who have a more
serious interest are just a wee bit
upset over this situation. Thank
you for your time and attention.
DAVID BLEUER

Thankfully, iPad0S 16 was
released just a week after
receiving David'’s email, but we
still thought that this was an
odd move by Apple in the
approach to the release of the
new O0S.

EMAIL: letters@maclife.com
SHARE WITH US! FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

Image rights: Apple Inc.
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THE GEAR WE'RE LUSTING AFTER

Leica Cine 1

STBC From leica-camera.com

>>> Leica is known for its cameras, but the
firm has now found a new area to explore:
projectors. The Leica Cine 1is the
company’s first ultra-short-throw laser
projector and can beam out 4K images up
to 100 inches across without needing a
massive distance between itself and the
projection surface.

It looks classy, incorporating Leica’s
renowned design sense into a sleek
aluminum body with an automatic dust

JAN 2023

cover to protect the lens. There's built-in
Dolby Atmos sound too, so it's also easy on
the ears.

Leica has been coy on any further
details, but according to The Verge, the
company is said to be working on two
models: one producing about 2,500 lumens
for a 100-inch 4K picture, and another with

200 lumens and an 80-inch picture. The This laser projector is set to
latter can sit just six inches from its bring the cinema experience to
projection surface. your home.

Image rights: Leica Camera AG.



DJI Avata

$1,388 From dji.com

>>> Aregular drone is a great way to get
a new perspective on the world, but
nothing beats the immersion of a
first-person-view (FPV) drone. These
devices let you don a headset and see
through the on-board camera, putting
you in the middle of the action.

DJI's new Avata is just such a drone. It
records in 4K resolution and 60fps for
smooth, high-res footage, and its 155-
degree field of view means you won't
miss anything on your flight. It's small
and rugged, letting it fit into the smallest
gaps and survive bumps and bruises.

There's also a DJI Motion Controller
that enables you to steer the drone with
a twist of your wrist or squeeze on its
trigger. That makes it easy to use and
quick to master.

Brydge ProDock

$399.99 From brydge.com

>>> Lacking space on your desk? The
Brydge ProDock takes the traditional
MacBook dock and turns it up to eleven.
It comes with three Thunderbolt 4
ports, three USB-A slots, one USB-C
port, a headphone jack, an SD card
reader, and an Ethernet port, going way
beyond what any MacBook offers.
There’s even a 15W MagSafe charger
built right in. And it lets you connect up
to two 4K monitors to the MacBook Air,
something it can’t do natively. So
instead of trailing countless cables to
your laptop, you just need one for the
dock. How's that for desktop efficiency?

i)
Bang & Olufsen
Beosound Theatre

$7.990 From bang-olufsen.com

>>> If you're serious about home
cinema, you want to get a great
soundbar, right? Bang & Olufsen’s new
Beosound Theatre takes things to
another level. It boasts 12 speaker
drivers, with two custom 6.5-inch
woofers and 800 watts of amplification
power. Every speaker works together to

produce immersive, 360-degree sound.

As well as that, the Beosound
Theatre is modular, so you can upgrade
and replace parts over time. It can even
be used as the centerpiece in a
surround sound system with up to 16
external loudspeakers.

Bluesound Powernode Edge

$649 From bluesound.com

>>> The Powernode Edge aims to take
the agony out of audio by combining
amplification, control, and streaming
sources into one handy device; all you
need to do is add speakers.

Its flexibility is key. The Powernode
Edge lets you add a set of passive
speakers to create a hi-fi system. You
could connect it to a wireless
subwoofer for a 2.1 stereo system, or let
it power a surround-sound setup.

The 2 x 40W amplifier supports hi-res
tracks up to 24-bit 192kHz, as well as
MQA audio, letting you enjoy original
studio masters of your favorite songs.

JAN 2023 | 11



TIPS, TRICKS
& SECRETS

The best iPadOS yet is a massive
upgrade for any device

WRITTEN BY CARRIE MARSHALL .'-i" ﬁ

—

Image rights: Apple Inc.
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E'VE COME A long way since
the firstiPad in 2010. That
one ran iPhone OS 3.2, and

critics mocked it as a giant iPhone. They
did have a point, but even then Apple was
making the iPadOS different from the
iPhone one — and with each new release,
those differences have become much
more significant. iPadOS 16 really blurs the
lines between iPads and Macs, especially
when it comes to multitasking.

iPadOS 16 isn't trying to turn your iPad
into a Mac, though. It's still very much a
mobile operating system that plays to the
iPad’s strengths: its portability, its
touchscreen and its ability to completely
transform based on the app you're using.

14 | JAN 2023

This is a very big update. It introduces a
brand new way of working with multiple
apps: it provides Mail and Messages with
some brilliant new features, it vastly
improves your security when you go
online, and it makes it easier to share the
things you love with the people that
matter to you. It can even turn back time
to undo embarrassing mistakes in
messages or emails.

Over the next few pages we'll discover
all the killer features of iPad0S 16, and
we'll show you how to make the most of
them. Whether you have the standard
iPad, an iPad Air or the biggest iPad Pro,
this OS update will make your iPad more
flexible, more fun and more you. =

Which devices
will work with
iPadOS 16?

iPad Pro (all models)

iPad Air (3rd generation and later)
iPad (5th generation and later)
iPad mini (5th generation and later)

Image rights: Apple Inc.
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Mail, messages
& collaboration

SharePlay

YOU CAN SHARE the current
playlistin Apple Music or the TV
shows you're watching in Apple TV+
via SharePlay in Messages, which
gives everyone in the conversation
shared playback controls so you can
enjoy the same content at the same
time. SharePlay also works with
apps such as Shudder, Disney+ and
more, although the person or people
you're sharing with need to be
subscribed to the same service(s).

CUFFITD

Experiencing your favorite content with
friends via Messages is now even easier.

Now it's easier than ever to share with others — and to change your mind

ANY FELT THAT Mail was

overdue some attention from

Apple, and if you agreed, then
you'll like the changes in iPad0S 16. The
new Undo Send can help you in those
heart-in—-mouth moments when you've
accidentally sent the wrong thing or to the
wrong person, and Mail will also warn you
if your message says you've included a file
or photo and forgotten to attachit.

You can now schedule emails to go at
specific times rather than right now, put
sent messages in your inbox for you to
remember to chase the recipient, and you
can also get Mail to remind you about
emails that you've looked at but haven't
responded to.

One of our favorite improvements is the
least spectacular-looking but by far the

most useful, though. Search has been
massively improved. What sometimes felt
like pot luck, and often proved very
reluctant to find messages we knew were
there somewhere, is much faster and
vastly more reliable, with Mail
autocorrecting search criteria to help
speed things up.

Messages gets an Undo feature too,
although the recipient needs to be using
the same app and the right version. You
can mark messages as unread, recover
accidentally deleted ones and send
invitations to collaborate on Numbers,
Pages, Notes, Keynote, Reminders and
Safari, or to share Apple Music and other
media via SharePlay. And it's easier for
developers to use the Messages
Collaboration API to add Messages

integration to their own apps, enabling you
to share different types of content with
more people.

SharePlay improves with each new
release, and it now works with more things
than ever before. Third party services
such as Disney+ and many third party
apps now have SharePlay synchronization
S0 you can watch, listen or interact with
them along with friends, family or
colleagues, and you can even share
Fitness+ workouts (provided that you're
both subscribers).

Not all the new collaboration features
were available from day one, however.
Freeform, Apple’s interactive whiteboard,
was penciled in for release at the very end
of the year, a couple of months after the
rest of iPadOS 16 was made available.

JAN 2023
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When to send... and
when to unsend

iPad0S 16's collaboration features are
a . ! } ]
COI I a bo rate Wlth oth ers just as useful for sharing with family
and friends as they are for work.
iPADOS 16 IS the most sociable
iPad OS yet. There are multiple

ways to share with others and
for others to share with you,

from SharePlay for music, TV, - o b
movies and apps, to the Shared b ot
With You tabs in Messages and - . !

Safari. Sharing and collaboration
is builtinto all of Apple’s key
creative and productivity apps
including Pages, Numbers,
Safari and even Reminders, and
it's increasingly available in
many third party apps too.
Whether you're communicating
about a big work project or doing
something fun with the family,
it's easy to start a Messages
conversation or FaceTime chat
from the Share icon.

AT AR i

Co-0p Sign-Up -

HOW TO Edit or Unsend in Messages

o - ] - v 4 rmy 20
- EX-X-X . RIE - — e
Linia S o L]
o 8 ' B
i = |:
|
. Keep r
4
1 Make your message Send it 3 Delete message
In this example we'll send a Our audio message has been Tap and hold on your message
hilarious audio message to someone sent — and it's blue. That's important, and you should now see the reactions
and then realize that maybe it's not so because the undo send feature only toolbar, along with a context menu to
hilarious after all. In Messages, create a ~ works with Messages, not SMS or other  the side of your sent message. Tapping
new message and then tap the messaging apps. The recipient also on Undo Send will make your message

waveform icon to record your voice. needs i0S/iPad0S 16 or macOS 13. disappear in a little puff of smoke.




HOW TO Unsend a message in Mall
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Send your message

You can't unsend a message until

L

you've sent it, so in this screenshot
we've crafted exactly the kind of mail
message that'll we'll regret sending
immediately: top secret plans should of
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The unsend button

Unlike recalling Messages, it
doesn’'t matter what mail app the
recipient uses: the unsending happens
in Mail before it's sent to the other
person. That means there’s a very short

iPad0S 16: Tips, tricks & secrets

Turn back time

Once you tap Undo Send, your
email magically reappears in Mail
exactly as it was before. You can now
tap Cancel to delete the message
altogether, or you can edit the

course be encrypted.

time to do it — just a few seconds.

message and then send it again.

HOW TO Schedule messages for sending later

Cancel
Embargoed until 09.00 GMT on 19 October: amazing book news ()

e hayinand@gmeliom

Embrarguad until (9,00 GMT on 19 Octaber: smanng book news

Press for longer

Instead of just tapping the send
icon, tap and hold it. You should now see
the scheduling menu with four options to
either send now, send tonight, send
tomorrow morning or send later. Select
that fourth option.

2

3 Pick your time

You should see a Calendar panel
that enables you to set the date and time
for your message to be sent. It's really
important that your iPad is both switched
on and online at the scheduled time or it
won't be able to send the message.

1 Create your message

Sometimes you need to write a message that won't be
sent until a specific time, such as a news announcement or
anything else you don't want to send too soon. Create your
message as normal in the Mail app.

Image rights: Apple Inc. JAN 2023 | 17
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Stage Manager &

multitasking changes

One of iPadOS 16's biggest changes is
also its most controversial

TAGE MANAGER, THE

new multitasking

interface in iPadOS 16,
has had a bit of a bumpy ride:
it's been widely criticized by
many prominent developers for
its bugs in the iPadOS betas,
and it's been suggested that
those bugs are at least part of
the reason for the delay in
getting iPadOS 16 released. As
things stand at the moment
Stage Manager is now officially
a beta feature, and even one of
its previously announced
benefits — external monitor
support — has been temporarily
removed. Device compatibility
has been changed too: what
was originally reserved only for
M1 and M2-powered iPads now
works on iPad Pros with A12X
and A12Z chips.

Stage Managerisn't on by
default: you have to switch it on
in the Control Center. Once you
do, your iPad moves into a
mode that looks more like the
Mac desktop with thumbnails
— Apple calls them App Stacks,
and they work in a similar way to
the tab groups in Safari but for
apps instead of open tabs — at
the left and the currentapp ina
moveable, resizable window.
You can have up to four apps
overlapping at once and
another four on an external
display, and it's a bit like using
macOS on a much smaller
screen. We think there will be
more significant changes
before Stage Manager loses its
beta label; it's one of the most
controversial interface changes
Apple has made in years.

External display &
display scaling support

IF YOU HAVE an M1 or M2-
powered iPad Air or iPad Pro,
there's a new display scaling
optionin iPad0S 16 to make
better use of your screen
space: if you go into Settings >
Display & Brightness > Display
Zoom you can select More
Space. This reduces the size of
on-screen elements such as
toolbars and icons so there's
more room for content. It’s

JAN 2023

particularly good in Slide Over
and Split View.

iPadOS 16 also enables M1
and M2-powered iPads to
display a separate desktop ina
16:9 aspect ratio. That's
primarily done through the
Stage Manager, but you can
also view apps on a second
display in Split View or Full
Screen. Or at least, you
could until the very final

.....

Stage Manager delivers something much

closer to the Mac's multitasking and
window system.

Don’t worry if you don't want
to use Stage Manager: the
familiar Split View and Slide
Over options still work perfectly
well, and at the moment those
are the ones we're sticking with:
as of the final public beta of
iPad0S 16 we found Stage
Manager was still very buggy
and needed a lot more work: its
tendency to crash means we're
not planning to use it for serious
work just yet. m

beta of iPadOS 16 when Apple
pulled the external display
support due to bugs. We don't
know when it's coming back.

.._'!-

-

e
_
Ly
4

(A
APP STACKS

Stage Manager's App
Stacks work rather
like Safari tab groups,
but show your most
recently used apps.
Tapping on a stack
opens it; tapping
another switches to
that stack instead.

Image rights: Apple Inc.
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[lyau will learn/{ B0ch
It will take 15 minutes
You'll learn what Spatial Audio is and how it

works

Ifquotejf
Spatial Audio tracks the movement of you

head and adjusts what you hear in your ears.

Ifkey facls)/

Spatial Audio delivers a surround sound
effect based on the position of your head in
relation ta your screen, so if you move your
head or move away from the screen the
audio you hear will change accordingly. It's
only currently available for AirPods Pro and
you'll need 105 or iIPadOS 14 or later to enjoy
it.

Spatial Audio works by analysing where you
are and then remapping the sound field so
that specific sounds appear to be in
particular places in a 30 audio stage. This is
done through making subtle adjustments to
spunds' frequencies and through the use of
audio sffects suck b. It works bast
when it's working Jti-channel audio

sources

gns | Sl

AirPods Pro (2nd generation)

B spplecom &

;3 aA

All-new

AirPods Pro

Watchthefilm ®)  Watch the event >

EXTRA WINDOW
CONTROLS

You'll recognize these
three dots from iPad
multitasking, but here
you can choose
between Zoom,
Minimize, Add Another
Window, or close the
selected app window.

FIRST APP
WINDOW

You can have your
open apps overlap
each other or just
stick them side by
side. To move an app
window just tap and
hold the top of it, and
slide your finger.

SAFARI APP
WINDOW

By default Safari will
show just the current
window, but if you tap
the Safari icon in the
doc you'll be
presented with
thumbnails of all your
Safari tabs/groups.

GRAB HANDLE
You can tap and hold
this little curve to
adjust the size of your
window. You can only
adjust the size so far:
this is as narrow as
Stage Manager will let
us make our writing
app, Ulysses.

RESIZING
Windows affect the
rest of the display
when you resize them.
Here we've made the
Safari window as big
as we can; any bigger
and the App Stacks on
the left disappear to
make room.

DOCK

The Dock lives in its
usual place, but you
can drag apps from
the Dock over the
main Stage Manager
area to open them as
new windows, if you
haven't hit the four-
window limit.

JAN 2023 | 19
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"What’s new in

photos' & video

The Photos app is smarter, faster to

use and more fun than ever before The new Find Duplicates feature can free up lots of space.

Being able to long- i
press on a photo’s |
subject and

remove it from its |
background feels

like magic.

Isolate from background

WE LOVED PHOTOS’
cutout feature when it
arrived in i0S 16 and we're
just as addicted to it on
our iPad: simply long-
press on the subject of an
image until you see it
briefly shimmer and you
can then copy it to
another app or share it
with others — so as you
can see in our screenshot
you can take a fairly busy
photo and remove its
background very
effectively. You can then

It's impressively easy to
isolate a photo's main subject.

useitasanimagein
Pages, senditin
Messages or even use it
as an iMovie background.
The feature works best
with images that have
strong contrast between
the subject and
background, but we're
frequently surprised by
how well it copes with
tougher images too.

The feature isn'tjustin
Photos: you can useitin
Screenshot, Quick Look,
Safari and Files too, again
simply by long-pressing
the image. Annoyingly
you can't save the cutout
as a new image; you have
to share it oropenitin
another app and save it
from there. But that's a
minor niggle for what's an
enormously fun feature.

Photo editing
improvements

PHOTO EDITING IS even better
in iPadO0S 16 thanks to the new
ability to copy and paste edits
from one image to another,
which is a huge time saver. Plus,
there are now simple undo and
redo buttons; you can sort the
People album by name; there's
the option to turn off memories
if you don't want to see them;
and the ability to lock hidden
albums and the Recently
Deleted folder so other people
can't take a peek at them.

The new Copy/Paste Edits
feature is brilliant: it |
enables you to apply

the same changes to
multiple shots.

One of the best new features
can save you money as well as
time. Find Duplicates will go
through your entire Library
(including your iCloud Shared
Library if you have one), find
duplicate photos and videos.
and enable you to merge them
for the best image/video quality
and metadata. It's very fast and
saved us gigabytes of wasted
iCloud storage — useful if youre
on a limited storage plan and
don't want to pay more.

It i LR [

Sadly not all Memories are welcome. You can now disable Memories in

Settings > Photos > Show Featured Content.

Image rights: Apple Inc.
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v Bath Librarias =

iCloud
Shared
Photo

Library

iPADOS 16 INTRODUCES a much
easier way to share images with your
nearest and dearest, or indeed with
anybody else you fancy inviting: the
iCloud Shared Photo Library. This
invitation-only library enables you to
manually share specific photos or
automatically share everything with up
to five other people, and they can add
their own images to the shared library
or edit and even delete yours. The
feature requires everybody to be using

You can choose whether all your new photos
should be shared automatically or if you'd
rather do it manually.

s

VIV ALBERTINE

Acquire your image

N0 e
You can switch between your normal library
and your shared library by tapping the
three-dot icon at the top right of Photos.

the most up-to-date OS for their
device, which is currently i0OS 16 for
iPhone, iPadOS 16 and macOS 13. At the
time of writing Apple had announced
plans to bring iCloud shared libraries to
Windows PCs too via its Photos app for
Windows 11.

The previous Shared Albums feature
hasn’'t gone anywhere, but iCloud
Shared Photo Library is more trusting of
the people you share it with. Everybody
with access to this new library has the
same level of permissions, so if you
don't want the kids drawing elaborate
mustaches on photos of you or deleting
the shots they don't like, then you
might want to think twice about using
this option over the normal shared
albums feature. For the same reasons,
if you want to share albums publicly
rather than with just your five trusted
people, Shared Albums remains the
safest way: it doesn’t let others edit or
delete the pictures and enables you to

Find out more

Personal Library A

Shared Library a9

f- v Shared Library Badge
'

Zoom in
Zoom Dul
Aspect Ratio Grid

Filter

g @ 0o 2 p

Show Map

share publicly rather than just to
specific people.

Once you've set up the shared library
you can decide whether you want to
see its contents integrated with the rest
of your Photos library, or you can view
each library individually: pressing on the
more icon — the three dots at the top
right — gives you a choice of Personal
Library, Shared Library or Both.

It's important to note that whoever
set up the iCloud Shared Library is the
one whose iCloud storage is being used
forits images. And for other users,
deleting an image doesn’t necessarily
mean permanent deletion: the Library
creator, most likely you, is notified of
deletions as they happen unless you
disable that option in Settings > Photos
> Shared Library. You'll then be given
the option of moving the deleted image
to your personal library instead. Deleted
images also remain in the Recently
Deleted album.

nnnnnn

LTIMATE
ERFORMANCE ' ©

Sam— 01 i RE

Grab from video

You can use Live Text in three
ways: using the live view in the Camera
app; by opening an image in Photos; or
by opening a video in the same Photos
app. Let's start with an image first.

Here we've highlighted the name
of the author and then tapped on Look
Up. This brings up key information: the
writer’s biography and key details from
it, and their social media profiles too.

You can't use Live Text as you
record video, but you can use it during
playback. This time we'll use the
Translation option to see what a
particular phrase would be in Chinese.

JAN 2023 | 21
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Safari &
passkeys

Passwords are rubbish,
which is why this new
option is both smarter
and more secure

ASSWORDS HAVEN'T REALLY
P aged well: they've become so

complex that we need iCloud
Keychain to manage them, and even then
websites keep leaking them to the baddies
and undoing all our best efforts to make
them completely incomprehensible. Enter
the simple and secure passkeys, which
are designed to change all that.

Passkeys are a new way of identifying
yourself to online sites and services, and
in Safari they are very simple to use: when
you're creating a login for a site that
supports passkeys, Safari will ask if you
want to create one and then ask you to
use Touch ID to confirm you're you. That

Maps
MAPS DIDN'T GET a massive
update, but it does get the same
multi-stop routing options as on
iPhone. Create a multi-point route
and then sync it with your phone.
Depending on where you are,
there is also support for various
transit cards — which you can store
in the Wallet on iPhone — and
details of the public transport fares
on your route, but that feature is
rolling out slowly: so farit'sonlyina
handful of cities worldwide.

Dea you want ba sive & passhkey for
“ehwla_boahmileleud com™? Panskiys ari saved in
your iCkoud Keyohain and are avallabla for gn im on a8

= POICURLE.CaN)

=
]

wour devices

Contioass wilh Touch ©

mrar og

Your passkeys will be end-to-end encrypted in iCloud Keychain, keeping them extra secure.

then generates a unique, encrypted
identifier that tells the site that you're not
an impostor. It's much more secure than a
password and pretty much useless to
anyone who manages to intercept it.

The only real downside to passkeys is
that they're tied to your devices. With
passwords, you can log in to something
with your user ID and password even if
you don't have your iPhone handy; with
passkeys, you'll need to have your iPhone,

Weather

IF YOU'VE BEEN pining for

an iPad version of the

wonderful Weather app on

iPhone, pine no more: the

iPad Weather app is here

and it's even more

wonderful now it's got more

room to play with. Apple has

taken full advantage of the

iPad’s big screen, packing

the app with fun animations,
detailed maps, and lots and

lots of weather data ranging

from predicted rainfall with hourly and
ten-day forecasts, to air quality and
UV levels. We think the iPad Weather
app is a beautiful thing, and we
particularly love the animated
backgrounds that show you what's

iPad or Mac with you to authenticate the
new device. It works very much like the
authentication you get when you try to log
into iCloud on a new device, where Apple
asks you to input the code it's sent to one
of your trusted devices. No code, no entry.
This is still a relatively new technology
butit's been embraced not just by Apple
but by Google and Microsoft too. We
should see a lot more passkey-supporting
sites and apps in the coming months. =

going on outside or in your chosen
location before you've even read any of
the on-screen data. The weather maps
are useful too, and there's a good
selection of Home Screen widgets that
make it easy to get a quick summary.

Image rights: Apple Inc.
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The Home
app gets a
revamp

THE HOME APP has a vastly
improved interface with new
categories for climate, security,
lights and speakers, and if you have
multiple cameras you'll like the new
multi-camera view. It's much more
logical than before, especially if you
have lots of smart devices.

One of Home’s most important
new features isn't visible. iPad0S 16
introduces support for Matter, a new
industry standard for smart home
tech that should make it much
easier for devices to work together.
If like us you have a mix of HomeKit
and other devices at home, that's
really exciting.

APPLE’'S UMBRELLA TERM

alot of Mac-like features

third party apps.

“desktop-class apps” refers to

including context-sensitive
menus for multiple selections,
toolbar customization, much
better printing features and
vastly improved find, search
and replace in both Apple and

The Freeform app wasn'tin
the initial iPadOS 16 update;

Apple promised it for later in
2022.1t's a collaborative
whiteboard for friends, family
or work that you can all see
and contribute to, and you can
chat viaiMessage or FaceTime
by tapping the canvas. The app
will work on iPad and iPhone,
but Apple Pencil support
means the iPad will be the best
canvas for getting the most
out of Freeform.

Family sharing

Botings

r-

2 - el gl '

Family Checklist

THE FAMILY SHARING and
parental control features of iPadOS
were already very good, but they're
much easier to view and change
thanks to the new Family Checklist
in Settings. Family Checklist makes
it much easier to review the
parental controls and content
restriction settings, as well as
enabling or disabling

location sharing and

iCloud sharing. You

can also create a

“recovery contact”, a

family member who

can get you back into

your iCloud account

if you forget or lose

your password.

improvements

Device setup

APPLE HAS ALSO made some big
improvements to the Quick Start
process to make it easier and faster
to set up new devices for your
family members. If you already have
accounts set up for them in Family
Sharing, you'll now see an option to
set up the new device for that
person — and if you use it, it'll
automatically set up the device with
all the sharing and parental control
options you've already set for that
account. It's not something you'll
use very often, but it's a very
welcome improvement for anyone
buying or passing on an iPad for a
family member.

Quick Start
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Prep your pics for printing

Editing tips on creating a print with more punch

rinting photos can
P often lead to

disappointing results.
The vibrant colors and rich
contrast of a photo viewed on
your iPhone or Mac's display
can often look dull and flat
when the image is printed out
physically. This is due to a
variety of factors. For starters,

your Mac or iPhone’s screen
displays millions of colors by
mixing reds, greens and
blues. In general, printers
create color by mixing cyan,
magenta, yellow and key
(black) inks (CMYK), which
results in thousands rather
than millions of colors
(though some printers use

HOW TO Print your pictures from Photos

Full quality

photo is downloaded.

by clear skin.

28 | JAN 2023
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If you use iCloud to sync photos
between your devices, then you'll need
to download the full version of a photo
before editing it. Click Edit. A circular icon
at the bottom right will appear while the

Perfect complexion
To make your print’'s subject look
their best, click on the Retouch panel’s
brush icon. Set tip size to around 18 (to
cover spots and pimples). Click on each
spot and it will automatically be replaced

or white edges).

Color and tone

For perfect prints of people, go to
Light. Tick Auto. This boosts overall
contrast to help the subject stand out.
In the Color panel click Auto. Drag the
preview thumbnail's slider right for

more saturated colors.

Stay sharp

In Sharpen, increase intensity to
0.80. This increases edge contrast and
makes details such as the specular white
highlights in eyes stand out more. Keep
Edges low to avoid halos (unsightly dark

extra inks for more faithful
results — see opposite). As a
result a printer’s dots of color
may not match the rich color
palette of the original digital
photo's pixels.

Sometimes colors such as
blue in a digital photo will
print with a slightly different
hue, as the printeris

incapable of printing the
photo's full range of colors.
Unprintable colors are called
“out of gamut” colors. In
high-end apps such as
Photoshop CC, you can turn
on a gamut warning (View >
Gamut Warning). This
reveals unprintable colors
with a gray overlay. You can

Vibrancy slider

You run the risk of making some

Print it

For best results place high-

Image rights: Apple Irwl:.
[

skin tones look too orange if you boost
Saturation. By using the Vibrancy slider
you can selectively boost the strength of
blues and greens without over-
saturating skin tones.

quality photo paper in your printer; cheap
paper will create drab and muddy colors.
Go to File > Print. Select a preset size if
you plan to frame your shot. Custom
enables you to choose a specific size.

|
|

- |



With a little editing (and by using high-quality
photo paper in your printer) your physical print
should look almost as good as the digital version.

then apply a Hue/Saturation
adjustment layer and tweak
the hue or saturation until
the gray patches disappear.
Photoshop users can
also choose a CMYK color
space to work in, which
displays a more printable
range of colors (rather
than using the default RGB
color space used to create
images for sharing via web
or social media).

PRINT READY

The rich contrast in a digital
image may look a little flat

in print. This is because your
on-screen digital image has a
higher dynamic range of
tones than its printed version
(especially when viewed on
an iPhone 13’s super-bright
OLED HDR display). Despite

the differences between how
an image is displayed on a
screen or in print, the good
news is there are things you
can do to get a better print,
even if you're using Apple’s
Photos app.

On the next page, we share
some ways to help bring out
more color, texture and detail
in your images, so your
photos look their best after
being printed by a third-party
company, such as Photobox
or Saal Digital.

we'll give you tips on
getting the best results from
your own desktop printer, and
you can also follow our
walkthrough for the i0S
version of Photos, and send
images wirelessly to printers
such as the Kodak Mini 2
Retro (see right). m

To help you identify and adjust unprintable colors, Photoshop CC has a handy
gamut (out-of-range) warning.

Image rights: Apple Inc, Adobe, Canon, Seiko Epson, Eastman Kodak Company, Polaroid.

TopS
Photo
printers

You might want to print a
snap straight from your
iPhone as a souvenir of a
family gathering, or to
showcase your photos as a
professional A3 print, for
example. Here's a range of
recommended photo
printers to suit a range of
needs (and budgets too).

Expression Photo XP-8700
$299.99 epson.com/usa

Send images to this printer from
your iPhone or via Wi-Fi from your
Mac and produce great-looking
photos thanks to its six Claria HD
Photo inks. A touchscreen enables
you to access photos from an
inserted memory card.

Polaroid Go

$99.99 polaroid.com

If you're of a certain vintage you'll
remember the thrill of snapping
and printing a photo straight from
a Polaroid camera. This modern
version gives you the retro
experience of watching an analog
print develop.

Print your photos

Canon PIXMA PRO-200

$599.99 usa.canon.com
This high-end printer is for
professional photographers to
produce prints with more
accurate color reproduction,
thanks to its eight-color, dye-
based ink system. It prints

up to A3 in size.

-_____.-l—"'

Kodak Mini 2 Retro
$119.99 shop.
kodakphotoprinter.com
This mini printer won't take up
much desk space at all, and
enables you to print 2.1x 3.4in
shots on the go via Bluetooth.
Each print is laminated for longer
lasting quality.

Canon imagePROGRAF
PRO-300

$899.99 usa.canon.com
This printer creates A3 prints so
professional photographers can
showcase their work. Ten-ink
technology ensures a wider color
range so your prints will match
the digital version more closely.
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e Feature

Turn your photos into a book
(or mug or jigsaw...)

Bring your digital photos to life on a range of products

he problem with
shooting digitally on
your iPhone is that

great shots can often get lost
as your photo library
increases in size day by day.
You may take the time to
create themed albums in
Apple’'s Photos app and even
share these albums with
other iCloud users, but many
digital images will barely be
glanced at for more than a
few seconds. A more effective
way to give a particular
picture more prominence is to
print it in a professionally
bound photo book, which you
can showcase on a coffee
table for visitors to flick
through. By viewing prints as
physical items they are more
tangible than pixels on a
screen and are therefore
deemed to be more valuable
and important. However, as
physical photo books can still

PHOTO COLLAGE

end up gathering dust on a
shelf, why not try printing a
favorite photo on everyday
objects (such as on a coffee
cup) so that you can enjoy
viewing a favorite picture on a
daily basis.

IMAGES ON OBJECTS

Your desktop printer might do
a great job but it's not geared
up to produce professional-
guality printed photo books
(or perform more complex
jobs, such as a printing a shot
on a mug or a jigsaw).
Fortunately there are plenty
of online third-party print
providers who can print

your shots on a variety of
products. Companies such as
Mimeo Photos, Saal Digital
and Motif all provide similar
print services. You can
browse through their range
of products (bags, canvas
prints, mugs, photo books

You could use your Mac to
manually lay out images in a
Photoshop CC document and
then scale and transform them
to create a collage, but the i0S

Photoshop Express app can do

the same job in seconds. Tap the

Collage icon then select up to
nine shots from your Library.
Choose a layout. Tap and drag
shots to fine-tune their
composition, then tap Share.

JAN 2023
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Bring your favorite iPhone shots together as physical prints in a glossy
hardback photo book. These also make great presents for friends and family.

etc) via Safari and upload
your shots to their sites.

If creating a photo book
you can choose custom
layouts and drag your
uploaded shots into
templates to design the look
of your book (see opposite).
Before uploading shots to an

Creative ways
to share your
captures

To give certain shots more
prominence you can print
them on a range of objects

— and they also make perfect
gifts for friends and family
members. Here are some
examples of creative ways to
share your photos on a range
of products.

online print service it's worth
tweaking colors, tones and
sharpness in Photos to make
them look their best. You can
also place the images for your
photo book in a dedicated
folder on your Mac so you can
find and upload them to the
print provider with ease. m

Marvelous mugshots!
$21.30 saal-digital.com

A picture of a pet on an everyday
object such as a mug is easy to
produce using Saal Digital's online
template. We created this design
with the High-Key Light Mono option
in the Photos app’s Portrait Mode.



Print your photos

HOW TO Turn your pictures into a glossy photo book |
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We'll demonstrate how to use Saal To take full creative control of the Click on the Add Images button.
Digital’s web-based service to design a book's look, choose Auto Layout. Choose Browse to a folder on your Mac to select
photo book. In Photo Books, click to a design theme for the book. We went for the images you want to include in the |

choose ‘30 x 21 Professional Line Photo the neutral and non-distracting Positive book. Click Upload. The images will

Book XT'. This comes with a protective Lines theme. Select a page count (we appear in the Project panel. Choose a ‘

acrylic cover. Click Design. chose 22 pages). layout for the cover. |'
=1 - = |

o Add images B Finish designing o Print and pay |
On each page you can choose a The Saal Digital Professional Line '

Drag images from the Project

panel into the layout template’s space new layout to add variety to your photo Photo Book that we received showcased
holders. If images are cropped, click ‘Edit book. Try to keep pages themed (such as our iPhone’s photos as vibrant and richly |
image’ and drag to recompose the shot. people and pets or street photography, toned prints on thick glossy paper. The |
Here we had to slide the workman up to for instance). When you're happy click book’s acrylic cover helped give it a I
‘Add to cart’. premium product feel. '

include him in the frame.

i R
i
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Personalized postcards Create a calendar Get on the case Mouse mat
$1.70 saal-digital.com $22.99 Motif, App Store From $39.99 snapfish.com $10.99 snapfish.com
A postcard personalized with your Motif was the company used by We're used to using photos as iPhone ~ Modern mice don't need a dedicated
own photo is an effective way to Apple to print photo books from wallpaper. Now we can print pictures  mat to function, but it can help stop
send greetings to friends and family Photos. Download Motif as a plug-in on a protective case and personalize  dust and fluff from clogging your
while on holiday. A social media post ~ for Photos and use File > Create to our device thanks to Snapfish's Apple mouse's sensor! Personalized
will soon disappear, but a postcard print straight to products such browser-based service. Select your mouse mats also help keep family
will be cherished for longer. as calendars from within Photos. iPhone model and upload your shot. members in mind as you work.
JAN 2023 | 31

Image rights: Saal Digital Fotoservice GmbH, RR Donnelley, Snapfish.



e Feature

Restore older photos

Turn analog prints into digital images and turn back time on faded photos

basement, you may have

boxes full of old photos
that haven't been seen for
years (or even decades). You
may also have envelopes full
of negatives. Some of your
prints might be easier to
access in physical photo
albums, but, over the
decades, time and chemical
reactions often cause colors

I n your attic, cupboards or

RESTORATION
SERVICES

Remini

$9.99 per month

(free 3-day trial)
App.remini.ai

Artificial Intelligence (Al) or
Machine Learning (ML) is a
common component of many
image-editing apps including
Photoshop CC (see steps 5-9
on the page opposite). One of
the most effective Al
services is Remini. This
browser-based service uses
Al to improve, sharpen and
unblur old photos to reveal
more detail. Browse to a
photo via Safari and upload it
to Remini. The online app
then analyzes the shot and
adds detail to blurred areas.
It is especially good at
adding detail to eyes and
hair. You can then download
the enhanced result.

JAN 2023

to shift in hue and tones to
fade. Other well-loved (and
well-handled) prints may
suffer from tears, scratches
and even coffee stains. You
may also have photos stored
on long-lost memory card
formats that you can no
longer access.

Fortunately it has never
been easier to digitize
these precious assets and

share them as prints or post
them on social media sites to
delight friends, family
members and followers.

Signs of wear and tear can
be digitally retouched to make
photos look as good as new,
and you can also use
scanners with slide adaptors
to digitize your assets and
turn negatives into digital
images (or send your

negatives to be digitized by
third-party providers). You
can even use iPhone apps to
scan and restore old photos,
turn an analog negative into a
digital positive or colorize an
ancient monochrome print!
Here we explore a range of
ways to recover photos from
a variety of formats
and restore them to their
former glory. m

TopS
Photo
accessories

Photography has its fair
share of left-behind formats
— negatives and slides, film
cartridges and old card
formats. But fear not, the
following devices can help
you rescue images from older
formats and turn them into
shareable pixels...

Wolverine F2D Titan
$149.99 wolverinedata.com
This standalone scanner digitizes up
to eight different film types
including 35mm film, APS slides and
negatives. A built-in screen enables
you to tweak colors and tones or you
can export photos to Mac via USB.

SanDisk ImageMate PRO
Multi-Card Reader

$29.99 westerndigital.com
Transfer photos from SD, MicroSD
cards and older CompactFlash cards
from digital SLR cameras of the
1990s. It works with USB 3.0 ports for
faster data transfer.

Photomyne Light Pad
$39.99 amazon.com
This backlit light pad is the perfect
accessory to use with the
Photomyne SlideScan app. Simply
place your slides or negatives on the
pad's flat surface and use the app to
digitize and edit them.

P

Plustek OpticFilm 8100
$349 plustek.com

This slide/negative scanner lets you
capture digital versions of your
original slides with a higher
resolution (7,200dpi) than you'd get
with an iPhone and a scanning app.
This leads to better-looking prints.

Epson Perfection V600
$299.99 epson.com/usa
This scanner ships with adaptors for
35mm film, slides and 120/220
medium-format film. A dedicated
film/negative scanner, it enables
you to digitize at a higher resolution
than scanning via an iPhone.

Image rights: Splice Video Editor S.r.I, Western Digital Corporation, Plustek, Wolverine Data, Photomyne Ltd, Seiko Epson.



Print your photos

HOW TO Scan and restore faded and/or damaged photos

n Scan photos Restore B Colorize photos
Photomyne’s Photo Scan app Photo Scan crops and rotates Photo Scan can bring people
scans and restores old prints straight each scanned shot and then restores it ~ back from the past and into the

from your iPhone. You can try it for by sharpening detail, increasing present by colorizing old black-and-
three days for free. Place up to four contrast and cooling down warm white shots. Simply scan the shot via
prints on a flat surface. Tap and hold colors for natural skin tones. You can the app (see step 1), then tap on the
Scan for three seconds to scan them. fine-tune the results using presets. ‘Colorize this photo’ button.

Heal scratches
Grab the Spot Healing Brush

o Repair damage

i0S apps such as Photo Scan

B Work in Photoshop

Choose Filter > Noise > Dust &

do a great job of sprucing up the colors  Scratches. Increase Radius. A larger tool. Spray over remaining spots or
and tones of digitized prints, but to value hides bigger scratches but can scratches. The tool fills the sprayed
repair dust specks and scratches you lose facial detail. Drag Threshold to the areas with adjacent patches of clear
need to manually retouch using right to compromise between hiding texture. Finish off by choosing Image >
desktop apps such as Photoshop CC. scratches while preserving detail. Auto Contrast for healthier tones.

aczel

Get smart o Skin smoothing Final touch

Photoshop can assist your To give the face a smoother As a finishing touch you can
restoration using Machine Learning complexion and reduce the presence add a wash of color to the restored
(ML). Choose Filter > Neural Filters. Turn  of grain, turn on the Skin Smoothing photo. Toggle on the Colorize neural
on 'JPEG Artefacts Removal’. This filter. Experiment with the Blur and filter. You can experiment with different
analyzes the shot and smooths out Smoothness sliders to help preserve looks by exploring the presets in the
some of the portrait’'s rough texture. important detail. Profile drop-down menu.

Image rights: Photomyne Ltd, Adobe. JAN 2023 | 33
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QREVIEWS

HERE AT MAC|LIFE we
believe you should
only buy the things
that you really need,
which is why our
Reviews section is so
important to us, and
you. We don’t want
you to waste time and
money on inferior products, and while we
aim to include only the best hardware and
apps, occasionally we like to include
products that look promising, even if they
don’t always deliver.

We only use carefully selected experts,
with specialist knowledge in their
respective field, so no matter which
review you’re reading, you can be
confident the person who’s tested it
knows their stuff, allowing you to make
an informed purchase.

Each review is rated using a five-star
system, with half stars, which is easy to
understand because we give an
explanation next to each one. The
products that really stand out, those with
a five—star rating, get a Mac/Life Editor’s
Choice award.

Mac|Life

EDITOR’'S
CHOICE

The products that really stand out in
the mag — those that receive a five-
star rating — get the Mac|Life Editor's
Choice award. It doesn't get any better
than this, so you'd be mad not to buy
anything bearing this mighty accolade.

GEARUP

The latest & greatest
hardware

36 iPad(10th gen)

40 iPadPro12.9in (6th gen)
41 1MORE SonoFlow

42 Audio-Technica
AT2020USB-X

44 Das Keyboard MacTigr

45 Creative Sound Blaster X1

46 OWCEnvoy ProFX

47 Kensington W1050

48 Marshall Woburnlil

49 Satechi USB-4 Multiport

50 BranchVerve

52 Group test: Mesh
network devices

APP LIFE

The most interesting Mac,
iPhone and iPad apps

58 BookFusion

60 Notenik10
61 Cultofthe Lamb

62 Parallels Desktop 18

64 Six apps to give Apple Music
aboost

66 Bestof the best
Mac|Life's pick of the best
apps and hardware for
Mac and i0OS




The new iPad offers
a choice of four
stylish colors.

Image rights: Apple Inc.



iPad (10th gen)

Base model gets a big upgrade, but that Apple Pencil..

From $449 (Wi-Fi), $599 (Wi-Fi + cellular) From apple.com

Features 10.9-inch Liquid Retina display with True Tone (2,360 x 1,640 pixels), A14 Bionic
chip, 64 or 256GB of storage, Wi-Fi 6, Bluetooth 5.2, USB-C, 12MP Wide camera (rear), 12MP
Landscape Ultra Wide camera (front), works with Apple Pencil (1st gen), 1.05 pounds

THE NEW iPAD finally takes Apple’'s base
model tablet into the future. Or at least the
present. The large bezels, ancient Home
button and Lightning port are gone, replaced
with a larger 10.9-inch display that nearly
goes edge-to-edge, a power button with
Touch ID built in and USB-C charging.

Measuring 9.79 x 7.07 x 0.28 inches and
weighing 1.05 pounds (1.06 pounds for
cellular), the iPad (10th gen) is thinner and
lighter than the iPad (9th gen), with a pretty
funky color palette to choose from.

Standard storage on the entry price model
is just 64GB, as with the previous iPad, which
is a bit low these days. For $599 (Wi-Fi
model) you can upgrade to 256GB — pricey.

The 10.9-inch display on the new iPad
won't blow you away, but it's good for the
price. Its 500-nit brightness level is decent
enough, but you may have a little difficulty in
direct sunlight. By comparison, the new iPad
Pro (p40) hits a much higher 1,600 nits, but
it's much more expensive. In terms of colors,
the iPad’s display covered 101.2% of the sRGB
color gamut and 71.7% of the more
demanding DCI-P3 color space. The iPad Air’s
hit a higher 111.8% and 79.2%, respectively.

IT'S AKIND OF MAGIC
The Magic Keyboard Folio for the iPad is an
excellent additional accessory to buy if you

want your iPad to double as a pseudo
MacBook. While expensive at $249, the keys
offer a good 1mm of travel and snappy
feedback. However, some of the keys are
shrunken on this layout given the overall
small size of the tablet, including the Return
and Delete keys. Another plus is that there's a
14-key function row at the top of the
keyboard, so you can easily see all your open
apps at once as well as adjust the brightness
and volume.

The Magic Keyboard Folio comes with a
kickstand that's easy to adjust, and typing is
fairly stable even with the iPad in your lap,
though it does bounce about a bit. The
protective back panel attaches magnetically
to the iPad. You can also remove the
keyboard if you simply want to use the back
panel as a stand for, say, watching a movie.

PENCIL PROBLEMO

For a company that prides itself on smart
design, the Apple Pencil support (or lack
thereof) is a real head scratcher. OK, so if you
buy the iPad (10th gen), the Apple Pencil (2nd
gen) won't work. If you want to be able to
draw, take notes and more on this iPad you'll
have to get the $99 Apple Pencil (1st gen).
0dd? You betcha. And the weirdness doesn't
end there. First, there's nowhere to house the
Apple Pencil whenit's notinuse. TheiPad =&

JAN 2023 | 37
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&2 Air and iPad Pro let you magnetically
attach the Apple Pencil (2nd gen) to the top
flat edge of their chassis for easy storage,
and they both charge the Apple Pencil while
connected. In addition, the removable cap on
the Apple Pencil (1st gen) is easy to lose.

It gets worse. In order to pair and charge
the Apple Pencil (1st gen), you need to use a
separate USB-C to Apple Pencil adapter. And
that's because the old Apple Pencil still uses
the outdated Lightning connector instead of
USB-C. The good news is that Apple will
include this mini dongle if you buy the Apple
Pencil (1st gen). The bad news is that this
awkward solution is needed at all. It would
have been much easier if Apple simply would

JAN 2023

If you plan to draw or
write with the new iPad,
be aware that it, oddly,
only supports the Apple
Pencil (1st gen).

have added Apple Pencil (2nd gen) support
to the iPad (10th gen).

ENTRY-LEVEL UPGRADE

No surprise here. The A14 Bionic chip that
powers the iPad (10th gen) is plenty fast —
and it should be given that this is the same
processor inside the iPhone 12. When playing
a game like Genshin Impact, the animations
were fluid and the iPad held up well even in
demanding scenes.

On Geekbench 5, which measures overall
performance, the iPad scored 1,580 on
single-core and 4,400 on multi-core, which
is a marked improvement over the 1,384 and
3,387 turned in by the iPad (9th gen).
However, the iPad Air with its M1 chip scored
a much higher 1,707/7151.

Turning to graphics, the iPad (10th gen)
scored 8,579 and 51.4 frames per second on
the 3DMark Wild Life test. Compare that to
8,000 and 47.9 fps for the iPad (9th gen). So
you're getting a slight graphics bump here.
The iPad Air, not surprisingly, earned a higher
17,966 and 107 fps.

Our review unit came with a 5G cellular
connection for Verizon, so we tried it out on
the Ookla Speedtest app. Near central New
Jersey, we saw only 38 Mbps downloads and
4.09 Mbps uploads, but downloads exceeded
100 Mbps in midtown Manhattan. 5G
performance really depends on your location
and signal strength.

SHARPER SNAPPER

The iPad (10th gen) packs an upgraded rear
camera, going from 8MP on the previous
model to 12MP on the new version. And the
12MP front camera gets a welcome shift
from the top edge to the long edge, which
makes for more natural video calls in
landscape mode, especially when your iPad
is docked in the Magic Keyboard Folio.

The rear main 12MP camera is a mixed
bag. Outdoors, it captures images that look
bright and colorful. Indoors, it fares well
when there's a decent amount of ambient
light, but there's some graininess in lower
light photos. You can forget about Night
mode, because there isn't one. And there's
no flash either.

Up front the iPad features a 12MP camera
with a new landscape location above the



TO PAIR AND CHARGE THE APPLE PENCIL,

YOU NEED A SEPARATE USB-C ADAPTER

long edge of the display. This makes the iPad
better for video calling. Even in a dimly lit
room the iPad delivered a fairly sharp image,
albeit with some noise. The iPad is smart
enough to light up the display, too, which
doubles as a pseudo flash.

The iPad (10th gen) should last you most
of the day on a charge, so you can probably
leave the included 20W charger behind. In
testing we easily saw ten hours from the
battery with a combination of web surfing
and watching video, which is what Apple
claims. The iPad (9th gen) also boasts the
same amount of battery life. We're glad that
the new iPad offers USB-C charging, as it did
result in faster recharge times in our testing
versus the previous model. The new iPad got
to 26% in 30 minutes, compared to 19% for
the Lightning-equipped iPad (9th gen).

Let's rip off the Band-Aid here and remind
shoppers that the new iPad (10th gen) does
not support the flagship feature of iPad0S

16: Stage Manager, which makes it easier to
multitask by putting your recently used app
on the left of the display. It does, however,
work on the latest iPad Air or iPad Pro.

The iPad (10th gen) is a tablet that looks
and feels new, and that’s a welcome change
over the last few iterations. However, $449 is
a lot of money to spend on what is effectively
the "entry-level" model. Yes, Apple is keeping
the $329 iPad (9th gen) around, but it still
stings to see a $120 jump from one
generation to the next. The bigger issue is
with the Apple Pencil situation; the difficulty
in charging is a bit of a dealbreaker, and
there’s nowhere to store it when not in use. If
that matters to you, then may we suggest
you spring for the pricier $599 iPad Air. It
supports the newer Apple Pencil (2nd gen)
that attaches to the tablet for storage and
charging. You also get the faster M1 chip, and
it supports the new Stage Manager
multitasking feature. MARK SPOONAUER

Apple has finally moved
the FaceTime camera to
along the edge of the iPad.

THE BOTTOM LINE

Almost everything
you want in an entry-
level iPad, but with a
couple of downsides.

Sleek new design

Great performance

Modern features

2 Apple Pencil calamity
GREATEEENR
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iPad Pro 12.9in (6th gen)

The world's fastest tablet just got faster
From $1,099 (Wi-Fi), $1,.299 (Wi-Fi + cellular) From apple.com

Features 12.9-inch Liquid Retina XDR display (2,732 x 2,048 pixels), Apple M2 chip
(8-core CPU, 10-core GPU), 8GB of memory (128/256/512GB)/16GB of memory
(1/2TB), up to 2TB of storage, Pro camera system with 12MP Wide and 10MP Ultra
Wide lenses, 12MP TrueDepth camera, Wi-Fi 6, Bluetooth 5.3, Face ID, Thunderbolt/
USB 4 port, 11.04in x 8.46in x 0.25in, 1.5 pounds or 1.51 pounds (Wi-Fi + cellular)

IN ISOLATION, THE new iPad Pro is one of the
best tablets thanks to its elegant design and
powerful new M2 chip. New iPadOS 16
features such as Stage Manager and Apple
Pencil hover also elevate Apple's flagship.

That said, the M2 chip is the only
substantial hardware upgrade over the
previous iPad Pro. Apple Pencil hover is
exclusive to this year's iPad Pro, but it’s not
exactly a “must—-have” feature for most
users. Unless you absolutely need the
nominal performance boost, it’s hard to
justify upgrading from a recent iPad Pro.

The new iPad Pro starts at $1,099 (Wi-Fi),
and $1,299 (Wi-Fi + cellular). In terms of
storage, you get a paltry 128GB with the basic
version, rising to 2TB for the priciest. It's
worth noting that the M2 chip comes in two
configurations depending on the storage you
opt for: the 128/256/512GB models get 8GB of
RAM, while the 1/2TB models get double at
16GB RAM. Clearly, your choice should be
dictated by how much storage you need,
rather than memory. It's unlikely you'll see
much of a performance difference anyway, at
least right now.

Note that the Apple Pencil 2nd gen (S129)
and Magic Keyboard (S349) are sold
separately and add significantly to the cost.

Design—-wise, the new iPad Pro is
indistinguishable from the two previous
models. This isn’t a negative since its thin
bezels and sleek aluminum chassis remain as
striking as ever. Space Gray and Silver are
the only available colors.

40 | JAN 2023

The Liquid Retina XDR

display is also unchanged, though again the
12.9—inch mini-LED 2,732 x 2,048 display is
already pretty much perfect.

Naturally, the piece de résistance is the
new M2 chip, a solid upgrade over the
previous model's M1. In Geekbench 5.4,
which measures overall performance, the
iPad (6th gen) scored 1,862 on the single-
core portion and 8,500 on the multi-core
test. In contrast, the old iPad Pro scored
1,722 and 7,298, respectively. When it comes
to graphics, the new model scored 25,259 and
hit 151 frames per second on the 3DMark
Wild Life Unlimited test. Last year’s iPad Pro
scored 18,263 and 109 fps on the same test,
which is a big deal for gamers.

The new iPad Pro’s cameras are exactly the
same as last year’s model. That’s both a
positive and a negative, depending on your
expectations. Since both the front and rear
cameras take solid pictures, it's not an issue.

In our battery test, the iPad Pro lasted well
over ten hours over Wi-Fi (a mix of web
surfing and video), which is about on par
with the previous model.

Hardware aside, there are two new big
features: Stage Manager in iPadOS 16 which
helps to focus on the current task (more on
p12), and Apple Pencil hover. This detects
the Pencil up to 12mm above the display,
revealing a preview of your mark before you
make it. This is useful for creatives aiming
for greater control, but it's not a killer
feature for everyone else. TONY POLANCO

The new iPad Pro is
identical to its predecessor
in terms of design.

THE BOTTOM LINE

A nominal upgrade
over its predecessor,
but the new Pro is
the best there is.

Speedy M2 upgrade

Fantastic display

Stage Manager

2 Not much of an upgrade
EXCELLENTHEmEEN




IMORE SonoFlow headphones

Hi-res wireless streaming you can afford

$99.99 From usa.lmore.com

Features LDAC codec support, 70 hours battery life, hybrid noise canceling, wired option,
Bluetooth (plus multipoint for pairing with two devices), 3.5mm audio output

THE SONOFLOW IS 1IMORE’s first over—ear
headphone. Lightweight at just 250g,
they’re comfortable for extended
listening sessions or wearing during a
commute but also feel well-built. In the
box there’s a USB-C to USB-A charging
cable and a full charge of 80 minutes will
get you 70 hours of playback with ANC off
or 50 with it on. A five—minute quick
charge provides up to five hours of
playback and though using full volume
will reduce these numbers a little, we
found them to be broadly accurate.

You do get a wired option which is
always nice to have, and a 2.5mm to
3.5mm cable is supplied. Bluetooth 5.0 is
also available and here supports the high-
quality LDAC codec for streaming at up to
990kbps, not far off the 1,411kbps of CD
and much greater than AAC’s standard
264kbps. You can hear the difference too
— where normally switching to a wired
connection boosts both clarity and max

volume, with these headphones wired and
wireless are equally impressive.

The 40mm drivers produce a sound
that’s more detailed than you might
expect in this price range, with excellent
stereo separation and reproduction that’s
faithful to your recordings. Overall the
soundstage is balanced, with mids only
occasionally straying into excessive
brightness with some material. Low end
is punchy and highs crisp, and you’re able
to use preset or custom EQs from the
companion iOS app if you wish. From the
app or the on-body buttons you can also
toggle listening modes, choosing
transparency or QuietMax hybrid noise
canceling. Unlike in pricier models the
canceling is on or off, there’s no variable
amount, but it’s very effective at blocking
sound. The five microphones that power
it are also used for making calls or using
voice assistants. An impressive feature
set at an affordable price. HOLLIN JONES

As well as hi-res Bluetooth
streaming, the SonoFlow
has a wired option and a
cable is supplied.

THE BOTTOM LINE

Solid sound and
great features on
a budget.

High-quality LDAC
streaming

Noise canceling
is effective

Long battery life

£ Noise canceling is
not variable

EXCELLENT mmmmI
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THE BOTTOM LINE

A great mic with
crisp, clear audio and
some nifty extras.

True-to-life sound

Clear mute light
Audio mix dial

£ Only one polar pattern
EXCELLENT mmmmi
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Audio-Technica AT2020USB-X

Perfect for podcasters

$149 From audio-technica.com

Features_20_l—|z—_26kHz frequency response, 24-bit/96kHz audio resolution, cardioid polar
pattern, microphone/computer mix dial, 3.5mm jack, touch-sensitive mute button, mute
indicator light, USB-A to USB-C adapter, two-meter USB-A to USB-C cable

AUDIO-TECHNICA IS WELL-KNOWN for its
selection of high-end microphones, most
of which use the XLR connector. That's fine
if you have the right equipment to plug it
into, but it's not so useful if you just want to
make some quick-and-dirty recordings on
your Mac.

The company’s AT2020USB-X microphone
changes that. It's not actually Audio-
Technica’s first USB mic offering (it's a
"reimagining” of the AT2020USB+), but it is a
serious contender for your cash if you're
looking for the perfect partner for your Mac
when it comes to streaming, podcasting, and
video calls.

The AT2020USB-X comes with a sturdy
metal stand that lets you adjust the mic
angle. On the bottom is a rubber layer to
cushion the mic and add grip, and there's a
small cut-out on the underside to pass the
two-meter USB-C to USB-A cable through.
The AT2020USB-X also comes with a USB-A
to USB-C adapter, which is ideal if you have a
USB-C MacBook. It's not a common inclusion
with USB microphones, despite most using
USB-A cables.

Around the back is a 3.5mm headphone
jack offering latency-free monitoring, which
is helpful for podcasters. On the front there
are two dials: one to control headphone
volume, and another to adjust the balance
between microphone input and computer
audio. The latter is a really nice touch,
allowing you to tweak the mix on the fly
rather than having to delve into software.

This is a rare find on microphones in this
price range.

AUDIO EXCELLENCE

Sound quality is first-rate, with voices
coming through clean, clear, and true-to-life.
Compared to our Blue Yeti, the AT2020USB-X
handily wins, which is impressive given the
Yeti's cachet. If you're after audio that
sounds great with minimal tweaks required,
Audio-Technica'’s mic is a good place to start.

If you ever need to quickly silence the mic,
there’s a mute button front and center. This
quickly flips the light emitting from the grille
from blue to red, making for an unambiguous
signal when the sound is off. We're not so
keen on its touch surface though — there's
no physical click when you press it, so it's
easy to accidentally mute yourself.

There are other areas where there is room
for improvement. There's no gain control dial
— while not essential, it would certainly be
welcome. The AT2020USB-X only offers the
cardioid polar pattern, which isn't ideal if
you're trying to record multiple people at
once. And you'll also need a separate pop
filter to protect against plosives, as there isn't
one built in (although that's not uncommon).

All of these drawbacks are "nice to haves",
though, rather than dealbreakers. There's a
whole lot to love here, from the clear mute
status indicator to the audio mix dial and, of
course, the superb audio quality. If podcasts
or streaming are your thing, this will be right
up your street. ALEX BLAKE



There are two dials on the
front to adjust headphone
volume and the audio mix.
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The MacTigr keyboard
features a full-size layout
with a numpad on the
right-hand side.

A dedicated volume
control is also included on
the top right.

THE BOTTOM LINE

A good upgrade
that falls short in a
few areas.

Great for typists

Solid construction
2 Very expensive

2 Lacks adjustment
options

GOOD mmm»
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Das Keyboard MacTigr

Is this the new Tigr king”

$219 From daskeyboard.com

Features Aluminum unibody, stainless steel top, two-port USB-C hub, Cherry MX switches

MECHANICAL KEYBOARDS MADE for Mac are
few and far between. If you want a solid
mechanical typing experience with a macOS
layout and keycaps, you’re limited to one or
two choices among a sea of Windows boards.

Now, there’s another option. Das Keyboard
has just launched the MacTigr, a set of keys
designed specifically for Mac users. They use
high-quality Cherry MX Red switches, giving
a comfortable, lightweight typing feel that’s
a step above the vast majority of traditional
Mac keyboards. Unlike some other switches,
there’s no tactile bump or audible click,
meaning they’re still (just about) quiet
enough for an office environment.

Right from the off, the MacTigr impresses.
Its chassis is all-metal and feels incredibly
robust, which is perfect if you intend to
travel with it. That’s complemented by the
low-profile keys, which reduce the overall
bulk noticeably. And those keycaps are
doubleshot, meaning they’re made from two

differently colored pieces of plastic, so they
won’t chip or fade over time.

In the top-right corner is a set of media
keys, a sleep button to snooze your Mac, and
a volume knob. The latter is a nice touch,
although we noticed it occasionally failed to
register turns. On the back are two USB-C
ports running at 5Gbps.

Still, there’s room for improvement.
There’s no adjustable stand, no alternative
switch choices, no backlighting, and no
wireless option. It’s also extremely
expensive, even for a mechanical keyboard.
Rival Keychron’s boards can switch between
Mac and Windows layouts, which we’d love
to see here, but it’s an unusual feature.

If you’re serious about typing, a
mechanical keyboard is the way to go. Das
Keyboard’s MacTigr is a premium board that
impresses in many ways. It’s far from
perfect, but still a good option if you’re tired
of mushy, lackluster keys. ALEX BLAKE

Image rights: Metadot.



LN ] CRIEATIVE

& Equalizer
g1 Flayhack
§ Recording
£ Setings

48

3 Bl 128 260 B K I 4K

Creative Sound Blaster X1

Enhance your Mac audio experience

$99 From creative.com

B 18K Proomp  Bage  Trebls

—

The Creative app includes
customizable EQ settings,
with the ability to create
your own presets.

Features USB-C DAC and amplifier, up to 115 dB SNR at 24-bit/96kHz playback resolution,
plug-and-play USB-C interface. Dimensions: 175 x 67 x 9.7mm, 15g

FORALLITS boasts of innovation, Apple
still has a tin ear when it comes to audio
technology. Its own AirPods can’t play
high-quality "lossless" audio, so music
fans who want the best sound quality still
need to use ye olde wired headphones and
a DAC — digital/analogue converter —
that can boost the sound quality.

There are several portable DACs
available for iPhone/iPad, and Creative’s
new Sound Blaster X1 is one of the most
affordable DACs we’ve seen recently. But,
somewhat oddly, it’s primarily designed
for use with Macs, PCs and gaming
consoles rather than mobile devices.

The X1 has a USB-C interface for
connecting to your Mac and a 3.5mm
connector for headphones, and there are
handy buttons for controlling volume and
voice calls as well. I noticed the difference
in sound quality from my MacBook Air as
soon as [ started playing the Hounds Of

Love album by Kate Bush. The hypnotic
drum loop on Running Up That Hill has
much greater impact, and the enhanced
clarity of the sound reveals a rather weird
left/right panning effect that I’d not
noticed before. The didgeridoo on The Big
Sky has a really rich, woody texture to it,
and the excellent slap—bass really lands
with a sharp snap.

There’s also a Creative app available for
macOS 10.15 or later — although this is
where things get a bit messy. The app
includes some useful EQ controls, but its
Super X-Fi feature for surround-sound
effects requires you to download two
additional apps — for both Mac and iOS
— and the whole process turns into a bit
of a struggle. Thankfully that’s non—
essential, and the X1 works fine on its
own as a compact and affordable option
for boosting the sound quality on your
Mac and other devices. CLIFF JOSEPH

The X1is highly portable
— but is primarily designed
for use with Macs and PCs.

THE BOTTOM LINE

The software is a
bit messy, but the
Sound Blaster X1
provides strong
sound quality at a
competitive price.

Improves Mac
sound quality

Compact and portable

Competitive price
B Poor Mac software
GREAT EEER
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Slim enough tofitina
pocket, the Envoy Pro FX
external drive connects to
almost any Mac.

THE BOTTOM LINE

Thunderbolt 4,
rugged, and very
flexible compatibility.

Superb performance

B Versatile connection

Rugged but compact
2 Fairly pricey
AWESOME nEEE®R
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OWC Envoy Pro FX

High-performance and versatile storage

$899 (4TB, range starting from $219 for 240GB) From eshop.macsales.com

Features High-performance SSD, Thunderbolt 3/4 and USB 3 compatible, water, dust and drop
resistant Needs Thunderbolt 3/4 preferred for best performance

THERE ARE FAST SSDs and versatile SSDs, but
only OWC’s Envoy Pro tries to be both, and
more. How can it be rugged yet fit into a
pocket, and push nearly 3GB/sec over
Thunderbolt 3 while still connecting to Macs
with only USB 3 support?

The Envoy Pro FX is the same size as most
SATA SSDs and significantly heavier at 90z
in its heat-dissipating aluminum case. OWC
claims IP67 rating for resistance to dirt, dust
and water, and military standards for
robustness to dropping. These were good
enough to take it into space in one of Jeff
Bezos’ Blue Origin New Shepard rockets. Its
deeply recessed USB-C port and 27.5in
combo cable enable it to connect to any
Thunderbolt 3 or 4, or USB 3 port, the latter
via USB-C or the supplied USB-A adaptor.

To do this SSD justice, you really want to
drive it through Thunderbolt 4. Benchmarks
are then impressive: Amorphous returns a

read speed of 3GB/sec and write of 1.8GB/sec,
although in use you’re more likely to see
towards 2.2GB/sec when writing to it, as
reported by Stibium. While 3GB/sec might
seem a long way from the 40Gbps promised
by Thunderbolt, it’s the practical limit
reached by surprisingly few external SSDs.
Most importantly, the Envoy Pro FX
performs excellently when it counts. Throw
100GB or more of video at it, and it won’t run
out of high—speed write cache or suffer
thermal throttling. You can install macOS on
it to use as an external boot disk with an
Apple silicon Mac, when it will start up
almost as quickly as from the internal SSD.
[t comes with essentials, such as full
TRIM support to ensure its performance is
sustained, and a year’s free subscription to
the Acronis back—up and protection service.
OWC has great ambitions in the Envoy Pro
FX, and it achieves them. HOWARD OAKLEY

Image rights: Other World Computing.



Kensington W1050 webcam

Customize your conference video on a budget

$49.99 From kensington.com

Features 1080p resolution, fixed focus lens, Kensington Konnect software, privacy cover

Needs macOS 10.15 or later

KENSINGTON'S WEBCAM IS designed for
those who want more control over the
video feed than Apple allows with its own
FaceTime cameras. The W1050 has a
relatively lightweight build but feels solid
enough, and a hinged foot that can rest on
the top edge of a laptop or monitor or be
mounted on a separate stand via its screw
thread. The body can be moved through
360—-degrees horizontally and 37-degrees
vertically, covering any angle you’d
realistically want to use. A privacy cover
can be slid across the lens when required.
The wide lens has a 95—-degree field of
view which is quite large if you’re sitting a
little way away from the camera, but the
Kensington Konnect software can be used
to zoom in up to 2x to tighten things up,
to pan or tilt, and the webcam’s fixed
focus works well. The 1080p image is a
little dark out of the box but does benefit

from some tweaking using the app,
correcting for ambient light with
brightness, contrast and saturation

sliders that can be saved as presets. There

are also effects presets to tweak the look
of the video, which are mostly useful.

The webcam has two microphones for
stereo audio and the noise canceling does
a good job of isolating your voice, even if
the overall audio is a little thin. The USB
cable is fixed to the back of the body and
at the other end is USB-A, so you may
need an adaptor. It’s possible to use the
camera right away with all popular
conferencing apps, but it’s worth
downloading the free software to
customize the look of the video. For
everyday conferencing this is a definite
upgrade for older Macs, though power
users should look at pricier alternatives.
HOLLIN JONES

The 1080p camera has
a fixed focus and a
95-degree field of view.

THE BOTTOM LINE

An affordable
webcam with handy
software controls.

Affordably priced

Make tweaks
in software

B USB-A native

B Sound is a little thin
GOOD mmmn
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As well as looking great in
any music setup the
speaker has an ARC input
for use with a smart TV or
in a home cinema setup.

THE BOTTOM LINE

Powerful and
detailed sound in a
great-looking
package.

Rich, detailed sound

Excellent build
ARC for use with TV

2 Expensive for a non-
smart speaker

EXCELLENT mmmmi
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Marshall Woburn |l

A home speaker with some serious heft

$579.99 From marshallheadphones.com

Features Five separate amplifiers, Bluetooth, aux and HDMI, playback and EQ controls,
Dynamic Loudness — adjusts the tonal balance depending on the volume

THE LARGEST OF Marshall’s new Home series
speakers, the Woburn III is relatively heavy
at around 161b and very clearly styled after
the company’s legendary family of guitar
amplifiers. Its finish is of high quality and
though you wouldn’t guess, is PVC-free and
also 70% recycled plastic, with beautifully
machined brass on the top panel. It leans
more towards a conventional notion of a
speaker so there’s no Wi-Fi or smart
features like voice commands, though it does
have Bluetooth 5.2 both for streaming from
devices and for managing settings. The
companion iOS app allows firmware updates
as well as control of a five-band software EQ
that’s user—configurable and also comes
with some presets.

In addition to Bluetooth with its 30—-foot
range you’ll find a 3.5mm aux input on the
top panel and RCA phono plugs on the back,
as well as an HDMI ARC input for use with a

smart TV or as part of a home cinema
system. Switching between inputs is as
simple as using the panel button, and you
also get a track play/skip control here as well
as guitar amp-style volume, bass and treble
dials. Internally, the woofer has a dedicated
90W amplifier, the two mid drivers have 15W
amps and the two tweeters do as well for a
total of five amplifiers.

This use of multiple drivers and amps and
some clever acoustic design makes the
Woburn IIT an amazing-sounding speaker.
Bass is rich yet controlled and far weightier
than you might expect from a relatively
compact model such as this. Mids are crisp
and direct, while the top end sparkles
without ever sounding thin. It’s also capable
of some quite astonishing volume,
maintaining focus well into the upper
reaches of how loud you are ever likely to
play it. HOLLIN JONES

Image rights: Zound Industries.



Satechi USB-4 Multiport

Versatile portable hub for MacBook owners

$149.99 From satechi.net

Features 1x USB-A (3.2), 2x USB-C, 1x HDMI 2.1 (4K @ 60Hz), 1x 2.5 Gigabit Ethernet,

1x audio in/out Needs Mac with USB-C

THERE'S NO SHORTAGE of portable USB
hubs available for use with your MacBook,
but choosing the right one can be tricky.
With no mains power supply these
portable hubs can only offer a limited
selection of ports and connectors, but
Satechi’s new USB-4 Multiport Adapter
manages to provide a good set of ports
and connectors that will be useful for
many MacBook users. It’s also up to date
with some of the latest technologies that
provide good performance for the devices
that you connect to your Mac.

The Multiport Adapter isn’t quite
pocket—-size, but it’s easy to carry in a bag
with your laptop when you’re traveling,
and sturdy enough to cope with a few
bumps along the way. We also like the
4.8—-inch USB-C cable, which gives you
some room to play with when you’re
connecting several devices at once.

The Multiport Adaptor is one of the
more expensive portable hubs, but it can

earn its keep with no less than six ports
and connectors. There’s a single USB-A
(3.2) port, and two USB-C ports, with one
providing up to 100W power output for
charging other devices (depending, of
course, on the power output of your
MacBook itself). There’s an HDMI port,
and this supports HDMI 2.1 with 60Hz
refresh for a 4K display. It’s also the first
portable hub we’ve seen that includes a
2.5 Gigabit Ethernet port for high-speed
wired connections.

The last option is a 3.5mm audio socket
— which might seem unnecessary, as
most MacBooks still have their own audio
sockets. However, this could come in
handy for podcasting or other tasks where
you might want to use external speakers
and a microphone at the same time.
There’s no slot for memory cards, though,
so photographers might prefer a rival hub
that swaps the audio port for a memory
card slot instead. CLIFF JOSEPH

The Multiport Adapter
squeezes six ports and
connectors into its
compact design.

THE BOTTOM LINE

Pricey but versatile
hub for MacBook.

Six ports and

connectors

Lightweight,
compact design

2 No memory card slot

2 Expensive
GREATEEEE
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THE BOTTOM LINE

Stylish, comfortable
and great for working
or even gaming.

Supportive & luxurious

Intuitive adjustability

Breathable & spacious
Beautiful modern form
AWESOME mEmEn
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Branch Verve

Style meets comfort in this ergonomic chair

$549 From branchfurniture.com

Features Six-point adjustment, 3D knit back, 27 inches x 27 inches x 37-41 inches (WxDxH)

THE BRANCH VERVE is all about giving you
the best of everything. It's classy and playful,
stylish and practical, aesthetic and ergonomic.
What's more, it's comfortable enough for work
and luxurious enough for play, making it a
terrific option for work-from-home
professionals whose work and play space are
one and the same.

The Branch Verve comes neatly packaged
and with all the tools you need for assembly.
Branch includes an instruction book in the box
to guide you through setup, but if you've
assembled an office chair before, you'll not
need it. The assembly is easy as well. You do
have to screw in the bridge, which secures the
backrest, and the arms to the seat, but that's
about it. Everything else you only need to
insert or pop in.

The seat is made of high—-density molded
foam covered in a soft weave fabric to give
your backside that plush experience. The
backrest is made of a 3D-knit polyester mesh
fabric that keeps things breezy and breathable

while also offering a hammock-like experience,

especially when you're reclining. The Branch
Verve comes in Galaxy (black), Mist (white), or
vibrant Coral.

There are six different types of adjustments,
including an impressively designed padded
lumbar rest that you can easily slide up or

WE NEVER ONCE HAD

BACK PAIN, EVEN AFTER

down the backrest’s inverted A-shaped,
glass-reinforced polyamide frame. Unlike other
lumbar support that pushes your back to arch
unnaturally, this one offers the support it
needs without putting you in a weird position.

You can adjust the seat height from 16.5 to
20.5 inches, which should cover most people.
Sadly, those over six-foot-five might find it too
short at its highest, but those under five feet
will find it perfect at its lowest.

We also love the armrests. They aren't the
4D kind you'd normally see on ergonomic office
chairs, offering just height adjustment, but
they do have a beautiful form and offer more
than enough padding for your arms.

The Verve doesn't just make adjustments
easy, but also intuitive to do. Most of the
adjustment levers are within arm’'s reach.
Meanwhile, to adjust the lumbar rest, you just
reach both arms back and push up or down
accordingly. The armrest height adjustment is
a no-brainer too. The only real struggle is the
tilt tension cycle dial. It's still within arm'’s
reach, but it needs some muscle to turn it.

Overall, we never once experienced back
fatigue or pain with the Verve, and we
sometimes put in 10 to 12 hours of work in a
day. The fact that its armrests are slim, instead
of unnecessarily thick, also makes it possible
for us to slip the chair under our desk when we
want to recline, but still maintain that
same distance from our monitor
without ever needing to adjust the

10 TO 12 HOURS OF WORK

height of either the desk or the chair.
MICHELLE RAE UY
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CHOICE

Proof that style can be’
fused with ergonomics.

Image rights: Branch.
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GROUP
TEST

REVIEWED BY NICK PEERS

ON TEST... |
> ASUS ZenWiFi XT9

> Devolo Magic WiFi 6 |
> eero Pro 6E |
> Google Nest WiFi

> Linksys Atlas 6 .
> Netgear Orbi 750 series |

141 D1oviy

MESH

NET
DEVIC

Extend your Wi-Fi network to all corners of your home
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Tough testing, trusted ratings

EVER STRUGGLED TO get decent
Wi-Fi coverage throughout your
home? If you have dead spots in
key areas, or your network is
overwhelmed with too many
devices trying to stream at once,
you need a mesh network. This
utilizes two or more devices

— routers and satellites — to
blanket your home in a strong,
stable wireless system.
Traditionally prices have been
prohibitively expensive, but as the
technology matures and new
options come to market, investing
in @ mesh network has become
increasingly affordable.

In this roundup we've taken a
selection of systems spanning
various budgets and technologies,
from older Wi-Fi 5 (or 802.1ac in
“old speak”) to newer Wi-Fi 6 and
6E technologies that can deliver
blistering speeds at greater ranges
than before. We've deliberately
focused on systems that comprise
two devices: a core router and one
satellite, designed to boost the
signal to a specific dead spotin a
regular-sized home.

Read on to discover if mesh is
the Wi-Fi network your home has
been missing.

AL AR RN

How we tested

We tested each system in a three-
bedroomed duplex with a 70-yard
backyard. We set up each router, explored
its features (including security settings)
and then installed the free Wi-Fi
SweetSpots app on an iPhone to
benchmark its performance and range in
various areas of the house. We then
installed one satellite in two separate
locations and benchmarked performance
in the same areas as before to see what
effect they had on the signal.
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Things to consider...
>>> WIRELESS CHANNELS

Does the system provide a dedicated
“backhaul” channel? This is used to relay
the signal from the router to its satellites,
and prevents your main wireless
channels from being saturated.

Mac|Life

EDITOR’'S
CHOICE

>>> LAN PORTS

Gigabit (1 Gbps) connections are the bare
minimum — ideally, the router will supply
one or more 2.5 Gbps ports too.

>>> PLACEMENT

The closer your satellite is placed to your
router, the stronger the signal it can relay
to other areas of your home. A good app
will suggest whether you need to move
the satellite for a better signal.

>>> MORE DEVICES

If you have two or more dead spots in
your home, consider investing in

additional satellites.

> ASUS ZenWiFi XT9

$449.99 From asus.com

This mesh system
1 pairs two AX7800
tri-band XT@ routers
together and can work with
any modern ASUS router that
supports AiMesh (basically
most models since 2018) to
expand your network further.
Setup is through the ASUS
Router app, and through the
web interface users can
access a set of eye-catching
services and options, from
AiCloud (remote access to
drives) to parental controls
and advanced security — no
subscription fees in sight.
Like the others on test, WPA3
encryption requires enabling
manually, but it includes
backward WPA2 compatibility

JAN 2023

so older devices are not
locked out.
Performance-wise, the
XTQ topped the charts in all
our tests. It's a powerhouse
of a router, with performance
and stability secured through
a dedicated backhaul
channel. It trounces the
similarly priced eero Pro 6E. If
you like the idea, but lack the
funds, ASUS's AX6000 XT8
system costs around S$S350.

Fantastic performance and range

Plenty of extra ports

Extra features don't require
a subscription

£ Very expensive
AWESOME NERER

> Devolo Magic 2 WiFi Next

$184.99 From devolo.com

2 Devolo’s offering isn't a
traditional wireless

mesh solution; instead, it
utilizes your electrical wiring
to deliver a strong, stable
Wi-Fi signal to where it's
needed. Two plugs are
provided — a LAN plug that
connects to your router or
modem, and a wireless plug
with two Ethernet ports to
extend both wireless and
wired connections to
anywhere in your home.

Setup is a simple case of
installing the app, then
plugging in both devices
within two minutes of each
other. More advanced
configuration is done using
the free Cockpit app.

There's a noticeable uplift
in performance, but the
Devolo is not as fast as other
Wi-Fi 6 devices. That's
because your maximum
speed is determined by the
quality of your wiring — our
wired connection maxed out
at 1,300Mbps. Nevertheless,
it's the best way to deliver a
stable network connection to
an outbuilding or far-flung
corner of your home.

Straightforward to set up

Extends both wired and Wi-Fi to
another location

Can place far from your router

2 Less range than its rivals

GREATHEEN



> eero Pro 6E

$499 From eero.com

3 Amazon's new flagship
mesh system is a

tri-band device offering
Wi-Fithrough 2.4 GHz, 5 GHz
and 6 GHz bands, the latter
exclusively for Wi-Fi 6
transmissions. Two Ethernet
ports for LAN or WAN access
are provided — one 1 Gbps.
the other 2.5 Gbps.

Each device can function
as either router or satellite.
Setup requires you to sign up
for an eero account, along
with an option to link the
eero to your Amazon
account, enabling you to
integrate it into your Amazon
smart home system.

The app is your only way
to configure and monitor

your network and offers
fewer options than those
found on other systems.
Parental control and security
can be added for an
additional subscription.

Performance was good,
but struggled at range —
potentially due to the lack of
a dedicated backhaul
channel. Amazon aficionados
should consider the cheaper
eero Pro 6 instead.

£ Performance on a par with rivals

© Does not take up too much room

B2 Lack of advanced
configuration options

B Most expensive option

SOLID mEm

> Google Nest Wifi

$149 From store.google.com

4 Google’s recently

announced Nest Wifi
Pro model arrived just too
late for this roundup, but it
gave us an opportunity to
check out the original mesh
option, now a budget choice
for those with no compelling
need for Wi-Fi 6 support. Our
speed tests confirmed that
while it's competitive over
the older 802.11ac network,
its more limited coverage
does adversely affect its
performance at the edge of
its range.

The satellite node serves
double duty as a home
assistant and smart speaker
(you can disable its voice
recognition if you don't buy

into the smart home ethos).
Setup is straightforward
through the Google Home
app, although advanced
settings are hidden away a
few taps from the main
screen. WPA3 support isn't
enabled by default, and
there's no compatibility
fallback for older devices. It's
fantastic value, but
remember you're investing in
yesterday’s technology.

Easy setup, simple to administer

D Satellite serves as smart speaker
B2 So-so performance

£ No support for Wi-Fi 6 (or the
Nest Wifi Pro)

GOOD mmmn»
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> Linksys Atlas 6

$279.99 From linksys.com

Linksys' Atlas 6 series

5 builds a mesh network
using multiple dual-band
routers capable of AX3000
speeds. Each router offers
three Gigabit LAN ports in
addition to the all-important
1 Gbps WAN port that
connects to your modem.
The Linksys app stands out
with its incredibly easy,
jargon-free and above all
painless set-up process.

Like all the devices on test,

the latest WPA3 encryption
isn't enabled by default —
annoying, because it
supports WPA2 as a fallback.
Performance-wise, the
Atlas 6 achieved excellent
speeds and a decent range,

JAN 2023

despite the fact it doesn’t
have a dedicated third band
for backhauling traffic
between satellite and router.
There was some lag on older
devices when first switching
to a new location, but this
quickly resolved itself and
given the major saving of
choosing dual-band over
tri-band, is a compromise
worth considering in return
for affordable Wi-Fi 6.

Excellent Wi-Fi speeds

Good value for money

B No dedicated band for
mesh traffic

2 WAN port Gigabit only

GREAT HEEN

> Netgear Orbi 750 series

$449.99 From netgear.com

This AX4200 system

from Netgear
combines a single router with
dedicated satellite nodes.
They look practically identical
— a tall, elliptical design —
but you can tell them apart
by the ports on the back: the
router has four (one WAN,
three LAN), while the satellite
has just two (both LAN).

An app is supplied for
setup, but perhaps in part
due to Netgear's extensive
mesh range, it feels slow and
cumbersome compared to
the other products we tested.
Again, WPA2 encryption is
enabled by default — in this
case, however, that's a
sensible move as the Orbi’s

WPA3 support comes with no
WPAZ2 fallback for old devices.
Other disappointments:

Netgear charges rolling
subscriptions for security
(Armor) and parental control
protection after a 30-day
trial. At least both
performance and range were
up there with the best on
test. An expensive choice,
even without those additional
subscription costs.

Excellent performance and range

Plenty of wired connection
options

2 Not the quickest set-up process

2 Very expensive
GOOD mmmn




THE WINNER
No

ASUS ZENWIFI XT9

Power, performance, range, security — the ASUS XT? has it all

IN THEORY, THE more you pay, the better mesh

system you'll get. That's why the ASUS XT9

comes out on top: it's the fastest on test, with

the widest coverage and a host of extra useful

features, including those (security and parental

controls) that are only available on subscription |

with rival products. For power users looking to

futureproof their home, it's our clear winner. |
If you don't need all the XT9’s bells and

whistles, though, you can find a system to

improve your home's spotty Wi-Fi coverage that

won't blow your budget. If you need to extend

your network to the far corner of your home, |

Devolo’'s HomePlug option is both effective and

affordable. If you want Wi-Fi 6 without incurring

a huge cost, then Linksys’ Atlas 6 system could

be the mesh network you're looking for. While

Google's Nest WiFi might be getting long in the

tooth, it's a cheap and effective option for those

with older devices. Ultimately, though, if you

want the best of the best, you'll return to the _

ASUS XT9, a mesh system suited to any home. ' i -

il
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& Sgarch THI9 Tus110ct
You can add your own ¢ NASA
libraries of books for
others to borrow. There
are also a few built-in to
the app, like this one

vics and Astronautics Cheanciogy

Afronon

from NASA.
Exploring the UnknawT 1L | l{l: ||-I “Ih
BookFusion
Read, organize, take notes on, and share your favorite eBooks
Free with limitations; subscriptions from $1.99/month From bookfusion.com
Needs iOS 12 or later; iPad OS 12 or later; macOS 11.0 or later
WHEN THE iPAD first  space. That might all have books to a BookFusion library.
launched, it seemed changed with BookFusion, You can “upload” them from
like the perfect however. This EPUB and PDF the files app on your iPad or
platform for reader and organizer is more iPhone (up to ten in the free
reading eBooks that, for flexible and more open than version of the app), or you can
whatever reason, weren’t Apple’s Books app, and plays buy them using the built-in
suited to e—ink readers like much more nicely with other book store. You can also
Amazon’s Kindle. In addition platforms, like Amazon’s “borrow” them from one of
to Apple’s iBooks, as it was at Kindle for example. the built—in public libraries in
the time, several third-party You can link your the app, of which there are
eBook readers launched and BookFusion account to your currently five, including a
created what seemed to be a Kindle account and import your = NASA library, with hundreds of
vibrant, growing market. And books, or you can send books books between them.
then... nothing. in BookFusion to your Kindle
Apple’s app improved and (up to two a month in the free A PERSONAL BOOK SHELF
very quickly didn’t just become  version). Aside from pulling in Once you’ve added books to
the standard, it pretty much your Kindle books, there are your library, you can edit their
killed innovation in the eBook several other ways youcanadd  metadata, including the book
JAN 2023

Image rights: BookFusion.
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To Sherlock Holmes she is always the woman. | haw

other name. In his eyes she eclipses and predominates
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any ernoation akin to love for Irene Adler. All emotions,

his cold, precise but admirably balanced mind. He wa

ohssrving machine that the world has seen, but as a le

position, He never spoke of the softer passions, save w

things for the obsarver—axcellent for drawing the wveil

trained reasoner to admit such intrusions into his ow

was to introduce a distracting factor which might throy

a sensitive Instrument, or a crack in one of his own high

than a strong emaotion in a nature such as his. And yet

"
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woman was the late lrene Adler, of dubious and questio

I had seen little of Holmes lately. My marriage had

complete happiness, and the home-centred interests w

himself master of his own establishment, were sufficie

® EReguiar Bold

who loathed every form of society with his whole Bohe fralic Hold Italic

You can change the font, size and color of text, as well as adjust margins and spacing to

make reading more comfortable.

cover, title, categories, and
tags. Books can be organized
on shelves or series. Shelves sit
within the Books section of the
app, while Series have their
own section. How you split
books between shelves and
series is up to you.

To make finding books
easier, you can hide shelves
— though not the All Books
shelf, which would be useful.
And you can choose to only
view books on a shelf that
you’ve marked as a favorite, or
a “plan to read”.

BookFusion excels as a
reader, thanks to the ability to
customize almost every aspect
of the layout from font and
type size, to the width of
margins and the spacing
between lines. We also like
that when you tap the
Contents button, instead of
taking over the screen like
Apple’s Books app does, it
slides out from the side and
takes up less than half the
screen, even in portrait view.

You can highlight sections of
text and make notes as you
read, and those notes can be

Image rights: BookFusion.

exported in a number of
different formats, including
text, HTML, and Markdown.

If you don’t like the
BookFusion reader, you can use
the Share button to open a
book in any app that supports
its format.

BookFusion is not without
its rough edges. For example,
while you can, sort of, sync
books, notes and highlights
across devices, it’s a one-way
process from the desktop
version of another eBook
reader called Calibre, and
needs a browser plug-in as
well as the Calibre app on your
Mac. KENNY HEMPHILL

THE BOTTOM LINE

BookFusion will be most useful to
organizations that want to create
their own libraries, but it's an
excellent eBook reader for the
rest of us.

Excellent customization options

Can import Kindle books

Built-in libraries

2 Syncing isn't really syncing

GREAT nmEN

Tough testing, trusted ratings

APPTIPS

BookFusion’s
handy features

= Seproh 1723 Tae 10 Ot
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dark mcidents of the Study in Scarlet, | waz sedzed wit!
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in his singular introspective fashion

"Wedlock suits you,” he remarked. *1 think, Watson, 1
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When you're reading a book, tap and
hold on text, then select it and tap the
highlighter pen to highlight it.
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Tap the screen when you're reading,
and then tap the middle icon at the
top right to see a list of chapters.
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Create series to keep books on a
theme together. In Bookshelf view, tap
Series then “+" and type a name.
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Notenik stores notes as
Markdown-formatted text
files that you can open and
edit in any application.

THE BOTTOM LINE

Notenik is a great
note-taking app for
creating libraries of
inter-connected
notes to be shared
online, and it's freel!

Notes stored as
text files

Lots of import and
export options

Powerful features
2 Mac only
GREATEEEE

JAN 2023
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Notenik 10

A powerful app for a customizable note-taking experience

Free From notenik.app
Needs macOS 10.13 or later
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NOTENIK IS A note—taking app
that gives you complete control
over your notes. They are stored
in folders as text files and you can
access and edit them in any text or
Markdown editor. You can sync notes
(though only with another Mac, as this is a
Mac-only app), but how you choose to do
that is on a folder—by-folder basis. For
example, you could host one folder, known
as a Collection in Notenik, in iCloud and
another in Dropbox or Google Drive.
Notes can be formatted using Markdown
and you can add footnotes, citations,

generate a table of contents for a long note or

collection of notes, and link to other notes
using double brackets.

When it comes to getting notes out of
Notenik, as well as opening the text file in
another application, you can use the Share
menu in the toolbar, publish to Medium, or
export to HTML, either as a series of notes in
one file or as a Web Book, where each note in
a collection has its own page and can be read

like a book. You can also import from and
export to tab—delimited files, CSV, and
OPML. And you can import from OmniFocus,
XML or text files.

As you would expect, Notenik allows you
to add tags to notes, but you can also add
other fields. These include current date,
status, creation date, author, and attribution.

Notenik also has support for recording and
running scripts, and generating reports of
their results. One such script “Populate App
Catalog” is built—in. Create a new collection,
run the script and Notenik will generate a
catalog of the apps in your Applications
folder (or any other folder you point it to),
including each app’s metadata.

As a native Mac app, Notenik’s interface,
menus and keyboard shortcuts all feel
familiar. However, the degree to which

you can customize it mean there are lots
of menu options, which can make it seem
intimidating at first. Fortunately, there’s an
excellent manual on the developer’s website.

There are a few idiosyncracies. The word
count feature reports words and characters
for entire notes, but we couldn’t do the same
for selected text. And we noticed that
whenever we clicked on a menu option while
editing a note, the note switched to display
mode and we had to select Edit to continue
editing. KENNY HEMPHILL
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You can create and run scripts, like this one that creates a
catalog of apps in your Applications folder.

Image rights: Herb Bowie.
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Cult of the Lamb

Time to play merry hell

$24.99 From cultofthelamb.com
Needs 0S X 10.9 or later

IN AN ALTERNATE reality,
where animals rule the world,
your cutesy cartoon lamb
protagonist smiles as they
dispose of unbelievers, desecrate their
corpses, and recruit new followers to their
cult in this indie action-adventure game.

The game begins with you being
sacrificed to the gods of the Old Faith. In
the underworld you are greeted by The
One Who Waits, who resurrects you so you
can launch a cult in their name and
destroy the Old Faith.

Back in the land of the living, you must
navigate your way through procedurally
generated levels, killing apostates and
freeing captives to convert them to your
sect. Recruits head to your base, and the
more followers you enlist, the more your
power grows.

Back at the base, you assign followers to
collect resources or pray at a shrine. At
the temple, you belt out sermons and
perform rituals to improve your
settlement’s faith. You need to manage
your followers’ needs in order to keep
expanding, and while there’s lots to do, it
feels manageable.

CHOOSE EVIL
The game makes it very clear that you are
to be as dastardly as possible. Followers

Preach to your flock to gain new abilities.

Image rights: Massive Monster.

Combat is fast-paced, challenging,
and thoroughly enjoyable.

exist for maximum
extraction in order to make
you — and thus the cult —
become as powerful as possible. It’s a

fun premise when you consider the
saccharine character design, and it feels
delightfully subversive.

Combat is fun and fast-flowing,
complemented by diverse enemy types
that encourage you to keep moving and
dodging. The procedural worlds borrow
other roguelike elements — dying sends
you back to the base to grind again, for
example — which keeps things fresh
and challenging.

It’s wrapped up in a world that is
cleverly crafted to give a weird, unsettling
feel that aptly suits its subject matter.
People speak in a strange, guttural
tongue. Monsters are Lovecraftian in their
appearance. Levels are beautifully
designed and dressed in a dark palette of
blacks, reds and purples. It really is
stunning to take in. Each run into the
procedural wilds feels like progress,
tempting you back for another shot at
godliness. ALEX BLAKE

Mac|Life
EDITOR'S ||
CHOICE

The game's eerie world is
crafted like a weird fiction
masterpiece.

THE BOTTOM LINE

Cult of the Lambis a
fanatically good
recruit-em-up.

Fascinating world
and premise

Gorgeous graphics
Fun combat

Multi-layered
base-building

AWESOME nmEEN

JAN 2023

61



@ Reviews | App Life

Parallels Desktop 18

Still the best way to run Windows, macQOS and Linux on a Mac

From $99.99; upgrades $69.99 From parallels.com
Needs macOS 10.14 or later, 4GB of memory

AYEARAGO, Parallels delivered
the first virtualization app to
- make full use of Apple silicon
= Macs, including Monterey virtual

machines (VMs). Five new Mac models later,
including the first M2 Macs, Parallels
Desktop 18 remains the only commercial app
to run macOS as a guest on those Macs.

Unlike open-source rival UTM, Parallels
can’t emulate different architectures: it runs
ARM guests on Apple silicon Macs, and Intel
x86 guests on Intel Macs. On Apple silicon
Macs, this new version still virtualizes
Windows 10 and 11 for ARM, four Linux
distros for 64—bit ARM processors, and
macOS from Monterey onwards, but not Big
Sur. On Intel Macs it will virtualize Windows
from XP and earlier to 11, almost any Linux
distro using Intel kernel 2.6.29 or later,
macOS from 10.7 to 13, and others including

Solaris, BSD and a special version of Android.

Virtualizing the OSes available for Intel
processors isn’t a challenge, but silicon Macs
are so different they need an alternative

62 | JAN 2023

Windows 11 for
ARM virtual
machines have
extensive
options to
support devices
including games
controllers.

approach. Parallels has worked with Apple
on a solution based on a standard already
used in Linux, using Virtio (for virtual input/
output) devices. These must be built into the
guest operating system to connect with a
device in the host macOS, so replacing
hardware-specific device drivers in a new
software framework. Apple has changed
Monterey and Ventura to support these
devices as both guest and host, which is why
Apple silicon Macs can’t run Big Sur in a VM.

For VMs running on ARM Macs this
enables almost all code to run at full speed.
Apple’s special display device also supports
Metal and GPU acceleration, delivering
performance as good as native macOS. Like
other apps using these new features in
Monterey and Ventura, Parallels Desktop 18
provides excellent compatibility and speed,
and supports the translation of Intel-only
apps using Rosetta 2, but it’s limited to the
devices supported by macOS.

Strangely, Apple decided that this doesn’t
include connecting to any service requiring
an Apple ID, preventing macOS VMs from
any access to iCloud services, syncing, or
iCloud Drive. As App Store connections also
rely on your Apple ID, macOS VMs can’t run
any third-party or paid—for apps from the
App Store, although Apple’s free apps like
Pages still work. While Apple could change

Sign In with Your Apple ID

el 8 A Badd 3

Installing mac0S on an Apple silicon Mac invites you to sign
in with your Apple ID, but it can't see it through.

Image rights: Parallels.
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its mind for Ventura, Monterey VMs will
probably never run most App Store apps, a
severe limitation for many potential users.

Some features in this new support for
Virtio devices aren’t available in Monterey,
only in Ventura. The worst is a lack of shared
folders to exchange files between macOS
guests and host, which needs a Virtio file
system in Ventura but not Monterey. An easy
workaround is using file sharing and virtual
networking, both clumsy and slow. Shared
clipboards also don’t work in Monterey,
preventing copy and paste between guest
and host. Users needing to change a guest’s
secure boot settings, perhaps to disable SIP,
require Ventura as the host, as entering
Recovery mode isn’t supported on Monterey
hosts. Parallels continues to fail to provide
GUI controls for macOS VMs on Apple silicon
Macs, which still have to be set up by editing
a text configuration file.

Start Parallels Desktop 18 on Apple silicon
to be drawn straight into downloading and
installing Windows 11 for ARM without
joining Microsoft’s Insider Preview program.
Licensing Windows for ARM remains
complex and controversial: some claim you
only need a valid Windows license to make
your VM legitimate if unsupported by
Microsoft. Larger enterprises need to check

Image rights: Parallels.
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their standing, as Windows 11 for ARM isn’t
sold by Microsoft — accessible through its
Insider Preview program only. Until
Microsoft clarifies licensing, doubt remains.

INTEL APPS

Parallels Desktop 18 improves compatibility
of Intel apps running in Windows 11 for ARM,
in particular in file access to disk to resolve
problems saving files from MS Office to
Shared Folders, and Counter-Strike: Global
Offensive now runs. Parallels claims only
0.01% of Intel apps remain unable to run on
Apple silicon Macs.

Got an M1 Ultra-powered Mac Studio? Give
your Windows 11 VM more memory and
cores: Parallels Desktop Pro and Business
editions can virtualize up to 62GB of memory
and 18 cores for full speed in Windows 11. All
editions can sync with and benefit from
ProMotion display refresh rates when set in
the host’s Display pane. There are also
improvements in USB 3.0 support for live
streaming devices, and for game controllers.

Parallels Desktop 18 is a worthy upgrade,
and best if you want easy access to macOS,
Windows and Linux on modern Macs. But
virtualizing macOS on Apple silicon Macs
still has drawbacks that won’t all be resolved
with Ventura. HOWARD OAKLEY

fl O = @ Q § Snm0es

Standard Linux distros like
Kali are simple and quick
to install, and have full
iCloud access.

THE BOTTOM LINE

The best virtualizer
giving easy access to
Windows 11 and Linux
on Apple silicon, but
still limited when
running macOS.

Windows 11 and
Linux support

Performance close
to host

Runs on Apple
silicon Macs

2 Apple silicon limitations

GREAT HEEN

JAN 2023
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(173 Give Apple Music a bit of a boost

Clever tools to enhance your music library svaLexsLake

10 of 50
1. Alone @
Rod Wave

— Beautiful Mind (2022}

3 Scrobbles

& & & &

Marvis Pro

$7.99 From appaddy.wixsite.com
Needs iOS 15.1+; mac0S 12.2+

Apple loves control, and that
extends to its apps. If you wish

Apple Music was a bit more
customizable, Marvis Pro could be for
you. While the player interface may seem
similar to Apple Music on the surface, it
conceals a huge range of features. You
can choose what metadata is shown on
the playing screen, whether the app
indicates the streaming quality of each
track, how playlists are sorted and
filtered, how tracks are displayed in your
library, and much more.

JAN 2023

Playlists

Forgotten Songs Most Played
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Most Played of
Ariana Grande

L

Most Played of
Country Genre

SongCapsule

$4.99 From sorcererhat.com

Check
Out Loter

Today In
Histary

The Fall of Mr. Fifths

Albums

Free (IAPs) From albumstheapp.com

Needs iOS 15.2+: macOS 121+

B If you're a bit bored of Apple

" Music's playlists, or just want a new
way to experience your library, definitely
consider giving SongCapsule a try. This
neat app scans your entire music library,
then automatically builds a bunch of
smart playlists for you to enjoy. From
deep dives into your favorite artists to
lists that help you rediscover forgotten
gems, you'll gain a new appreciation of
the tunes you love. SongCapsule also
uses iCloud to keep your music in sync
across all your devices.

Needs iOS 15.0 or later

W7 For many artists, an album is a way
@M to impart a crafted story onto the
listener — but that gets lost if you stick to
singles and playlists. As the name
suggests, Albums puts the focus
squarely on complete records, letting you
browse through album art, skip to the
next album in your library, or shuffle
through tracks on each record. All the
core functions, including iCloud sync, are
available for free, though if you want
more useful tools at your disposal,
Albums Premium is $1.99/month.

Image rights: Aditya Rajveer, Sorcererhat, Adam Linder.



Planet Her (Deluxe)

. Run Into Trouble - Single

MusicBox

$2.99 From marcosatanaka.com
Needs iOS 15.0+; macO0S 12.0+

There's not always time to listen to
B your favorite tracks, but that's
where MusicBox comes in. It's a “save for
later” app that can store all the tunes you
don't have time for right now. It also lets
you add tags and notes, categorize
albums and individual tracks, handle
metadata, and much more. You can add
music by drag and drop, pasting a URL,
or from a share sheet, then create smart
filters to find just what you need. It's a
deeply clever app and is also well-
integrated into i0S.

Image rights: Loop Apps, Lucas Klein.
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MusicHarbor

Free (IAPs) From marcosatanaka.com

Tough testing, trusted ratings
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snd.wave

Free (IAPs) From sndwave.app

Needs iOS 14.1+; mac0OS 11.0+

Keeping up with the latest releases
. can be challenging, especially if
you follow a lot of different artists.
MusicHarbor might be the answer, as it
shows you all the latest music from
artists and labels you follow, as well as
upcoming music sorted chronologically.
You can tune it to your liking, hiding
collaborative releases and filter albums,
singles, compilations, live shows, and
more. And it even keeps you up to speed
with the latest artist happenings from
Google News.

Needs iOS 11.0+; mac0OS 1.0+

.. When you consume a lot of music,

~ you rack up the listening hours
pretty quickly. If you've ever been curious
to know what your top albums are or how
many hours you've spent listening to
Rick Astley (what, just us?), snd.wave has
your back. Aside from your top charts, it'll
show you stats for any track in your
library, let you see how you stack up
against other listeners, and help you
clear out some of the songs that you
never listen to. That makes it both
informative and useful.
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@ Reviews | Best of
Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check
in here — we've highlighted the best in every major category, as voted for by us

> HARDWARE

E ‘ MESH ROUTER ASUS ZenWiFi XT9 asus.com $449.99  #201
4K USB-C MONITOR Ben( EW3280U beng.com $799.99  #169
THUNDERBOLT DOCK CalDigit Thunderbolt Station & caldigit.com $379.99  #199
KEYBOARD NuPhy Air75 Wireless Mechanical nuphy.com $109.95 #189
PORTABLE PRINTER Epson WorkForce WF-110W epson.com $299.99  #185
PORTABLE HDD Toshiba Canvio Flex 2TB storage.toshiba.com $79.99  #197
NAS DEVICE Asustor Drivestor 2 Pro AS3302T asustor.com $249 #190
WIRELESS CHARGER Belkin BoostCharge Pro Portable belkin.com $59.99  #197
DESKTOP SPEAKERS Klipsch ProMedia Heritage 2.1 klipsch.com $349 #196
IN-EAR HEADPHONES Beats Fit Pro beatsbydre.com $199.99  #190
SECURITY CAMERA EufyCam 2C (two-pack kit) eufylife.com $239.99 #17
SMART SPEAKER HomePod mini apple.com $99 #176
OVER-EAR HEADPHONES Sony WH-1000XM5 sony.com $399.99  #197
AIRPLAY SOUNDBAR Sonos Beam sSonos.com S449 #187
WEBCAM AnkerWork B600 Video Bar ankerwork.com $219.99  #191
PHOTO PRINTER Liene 4x6 photo printer amazon.com $136.99  #190
PORTABLE BATTERY PACK Anker 533 us.anker.com $49.99  #198
MOBILE DOCK Kensington 8-in-1USB-C Mobile Hub kensington.com §7155  #190

E ‘ OFFICE CHAIR Branch Verve branchfurniture.com $549 #201
MOUSE Logitech MX Master 3S logitech.com $99.99  #198
ACTION CAMERA Insta360 ONE RS insta360.com $299.99  #199
SMART TV PLAYER Roku Streaming Stick 4K roku.com $49.99  #190
PORTABLE DAC iFi Go Blu ifi-audio.com $199 #189

E ‘ PORTABLE SSD OWC Envoy Pro FX eshop.macsales.com $219 #201
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>i0S/iPadOS APPS

cATEGRY lPRODUCT _lweB __IPRICE__[IsSUE_

NEW!

T0 DO (PRODUCTIVITY) Things 3 culturedcode.com $9.99 #194
WRITING & Scrivener literatureandlatte.com  $19.99 #138
EMAIL Spark sparkmailapp.com Free #190
PHOTO EDITOR @ Pixelmator Photo 2 pixelmator.com $4.99 #193
VIDEO EDITOR @8 LumaFusion30 luma-touch.com $29.99(IAPs)  #186
CAMERA @ obscura3 obscura.camera $9.99 #196
RSS READER P Reeder 5 reeder.app $4.99 #176
IDEAS ORGANIZER o OmniOutliner3 omnigroup.com Free (IAPs) H141
NOTE-TAKING Notability 10 gingerlabs.com $8.99 #174
MIND-MAPPING ¥ MindNode7 mindnode.com $14.99 #184
DOCUMENT SCANNER == Genius Scan 6.0 thegrizzlylabs.com Free (IAPs) #182
CALENDAR % Fantastical 3 flexibits.com $4.99/month  #198
WEATHER & Carrot Weather 5 meetcarrot.com $0.99/month  #180

CATEORY __[PRODUCT ___[WEB _____[PRIcE__[ISSUE_

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

PHOTO EDITOR

VIDEO EDITOR
SCREEN CAPTURE
MUSIC CREATION
PASSWORD MANAGER
DESKTOP PUBLISHING
BACKUP
VIRTUALIZATION
TIME-TRACKING
VIRTUAL PRIVATE NETWORK

Things 3

& Scrivener
Spark
Luminar Neo
7% Final Cut Pro
% Screenflow 9
B Logic Pro

m LastPass

B Adobe InDesign
[# Carbon Copy Cloner
B Parallels Desktop 18

@ Tymes

@ NordVPN

culturedcode.com
literatureandlatte.app

sparkmailapp.com

skylum.com
apple.com
telestream.net
apple.com
lastpass.com
adobe.com
bombich.com
parallels.com
tyme-app.com

nordvpn.com

$49.99

$49

Free

$79

$299.99
$129.00
$199.99

From $3/month
$20.99/month
$39.99

From $99.99
$3.99/month

$11.95/month

#194

#200

#190

#194

#124

#164

#14]

#188

#162

#136

#201

#169

#186
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GET STARTED WITH

Purchases and
subscriptions

Whether it's renting movies,
streaming music, or buying
books, you can get it from Apple

WRITTEN BY KENNY HEMPHILL

v

‘ THE LAST COUPLE of decades have seen

v Apple transition from being a maker of

hardware and software, into a full-blown

media company that secures distribution deals for
movies and buys screening rights to major sports
leagues. Since it started selling music downloads in
2003, Apple has added movies and TV shows to rent
or buy, books, magazines, streaming music,
streaming TV shows and movies, games and, of
course, apps. Most recently of all, it’s entered the
realm of Peloton and the like by enabling you to
subscribe to exercise classes through Apple Fitness+.

All of these can be bought, rented or subscribed to
from your Mac or iOS device. But the way in which
you do so, and just as importantly, the way in which
you cancel a subscription, is not always obvious, so
over the next few pages we’ll take you through how to
do just that for all the content Apple provides.
Whether you want to buy a movie or ebook, subscribe
to a premium podcast, or sign up for Apple Music,
here’s how... s

Image rights: Apple Inc. JAN 2023 | 69
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The iTunes Store lives on in the
Music app on the Mac and its own
app ini0S.

Buy, rent or subscribe

There are several options for consuming music, TV and movies from Apple

UNTIL RELATIVELY

v‘ RECENTLY, if you wanted
to listen to or buy music

on your Mac, rent or buy a movie, or
subscribe to a podcast, you would
head for the same app: iTunes.
Now, you have three apps to
navigate, depending on what you
want to do. Despite the increase in

the number of apps, though, it’s now
easier to find what you want. iTunes
had become a sprawling mess of an
app, and its replacements are a big
improvement. However, the iTunes
Store lives on. There’s still an app in
iOS 16 and the store in the Music app
still bears its name. In the TV app,
however, it’s just called Store. The

QUICK LOOK Music's interface

TUNE VIEW

The Apple Music section
enables you to choose how
you view songs on Apple’s
streaming service.

ALL OR
DOWNLOADS

You can choose to view
all the tracks in your
library, or only those that
you've downloaded.

JAN 2023

The Bast... Allsm in Tha Waorld. . Evert (Disz 1)

iTunes Store app sells music, TV
shows and movies, while on the Mac,
as we’ve discussed, Music is accessed
in one app and movies and TV shows
in another. But if you want to pay for
a season pass for a current show in
i0S, you do that in the TV app.
Confused? Here’s how to navigate
those apps and find what you want. =

BUY SONGS

The iTunes Store enables
you to buy tracks and
albums you can download
for offline listening, instead
of simply streaming them.

RADIO STATIONS
Under the Radio section is
where you'll be able to find
all of the Apple Music radio
stations and programs to
listen in to.

Image rights: Apple Inc.



Print your photos

HOW TO Find and pay for content in Music, TV & iTunes

Subscribe to Music

In the Music app, click Account
then Join Apple Music. Sign in with
your Apple ID, then follow the
instructions. To manage an existing
subscription, click the option in
Account > Account Settings > Settings.

Lenres Faaturad Charts

MNew Music
Fatlent @ Darker SUIl @ Nethertheaoven  “Swrvivel of @ Me
¢ tha Sicka.. Cla

Mumber 8

Firtieniie hdatallism

iTunes on i0S

Tap the iTunes Store app. then
tap Music at the bottom. To search for
a song, tap the magnifying glass and
type in the search field. Tap Genres to
see music categorized by genre, or
Charts to see current hits.

~ B

stv

9 Get a season pass
Inthe TV app on Mac or i0S,
click or tap Store then TV Shows. Click
or tap the show you want. Scroll down
to "How to Watch". If a season pass is
available, you'll see a Buy Seasons
card. Click it and choose a season.

Image rights: Apple Inc.

o Apple One
Apple One includes Music

streaming, Apple Arcade and iCloud
storage. Go to System Preferences and
click Apple ID. Choose Media &
Purchases, then click Manage, next to
Subscriptions. Select a tier.

{ Alternative

How To Be a Person Like Other
People

$4.09 |

Songs Reviews Related

Purchase music
When you find the song you
want in the iTunes Store, tap it to
preview it, then tap the price to buy it.
Tap an album to see a track listing. On
the Mac, click a song to preview it or
click the price to buy it.

A 0w
DEHES
Tl

o Find purchases

In the Music app on Mac, scroll
to the bottom of the screen and click
Purchased. In the TV app, click Library,
then Movies or TV Shows. In the iTunes
Store app. tap the "." icon at the
bottom of the screen, then Purchased.

—
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P
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iTunes on Mac

In the Music app, click iTunes
Store in the sidebar. Navigate using
either the cards in the main window or
the options on the right-hand side. To
search for something, type in the
search field and choose iTunes Store.

o Buy a movie (Mac)
Launch the TV app and click
Store > Movies. When you find the
movie you want, click it and select Buy
or Rent. Not all movies are available
with both options. For TV shows, which
can only be bought, click TV.

Wiraga Devess

o Manage access

In Music on Mac, click Account >
Account Settings. Go to "Downloads
and Purchases”. Click Manage Devices,
then Remove. In i0S 16, go to Settings
> Apple ID > Media & Purchases > View
Account > Remove This Device.
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Denial, Anger, Acceptance

Meadowlands

If you buy an entire season of a TV
show, you can download the whole
thing or individual episodes.

Do more with the apps

Here's how to hide items, manage downloads and subscribe to apps

‘ MUSIC, TV SHOWS and
v movies are only a few of
the digital goodies Apple
now offers. You can buy books in the
Books app, subscribe to newspapers
and magazines in News, get access to
hundreds of games in Apple Arcade,
and pay for premium versions of
podcasts in the Podcasts app. And

Fitness+, Apple’s suite of exercise
classes, is now available to all iPhone
owners instead of being restricted to
those who also have an Apple Watch.
Add to all that the variety of
subscription options for third-party
apps, different tiers for iCloud
storage and the Apple One grouped
plans, and it can quickly become

complicated, with lots of different
subscriptions to keep track of.
Thankfully, every subscription you
pay for via Apple is available to view
on any device signed in with your
Apple ID. We’ll show you how to find
out which subscriptions are active,
which have expired, and how to
cancel those you no longer want. m

HOW TO Manage downloads

? Amazing Grace: The Comgieie Recordings (L)

T T S — DA TR p——

13 Episodes

- 1. The Sopranos L

4
- 2 G LDng d’
m 3. Denial, Anger, Acceptance

Movies and TV
In the TV app on Mac, click

N ——

&«

Delete downloads

In the Music app on Mac, click

Download music

In the Music app on Mac, click

the down arrow next to the album you
want to download. To download a
song, hover over it and click the down
arrow. In i0S, tap the down arrow, or
tap the more button next to a song.
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Library then a category in the sidebar.
Find the show/movie you want, hover
over it and click the download button.
In the TV app on iOS, locate the movie/
show, tap it then tap the down arrow.

View > Only Downloaded Music. Pick
the album you want to delete, click the
"."icon and Remove Download. In i0S,
tap Library > Downloaded. To delete
the item you want, tap "." and Remove.



HOW TO Hide or unhide purchases on Mac

Purchamed s O b b

: = T
O R

Hide music

Hidden music disappears from
your library and libraries of those you
share with. In the Music app, click
Account > Purchased, then Click All.
Hover over the item you want to hide
and click the "X" in the top-left corner.

MR-

Hide movies or TV
Launch the TV app on your Mac
and click Library. Find the item you
want to hide. Click the "." icon and then
choose "Delete from Library". In the
dialog box, click Hide Movie or Hide TV
Show to remove it from your library.

HOW TO Subscribe to and cancel apps

Give Balance a try

Get unlinmted access to all featurss

tart your 7 days free trial now and then pay:
o Buy a subscription
Go to the App Store and find the
app you want to download. When it's
downloaded launch the app. You will
usually be shown a pop-up offering
the premium subscription or a free
trial, so tap the one you want to go for.
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Tweetbot for Twitter
Tweetbot Yearl £5.00

9 Pay and check

Confirm the payment on your
Mac or i0S device by following the
instructions on screen. Go to Settings
> Apple ID. Tap Subscriptions and then
the name of the app, and you'll see
details of your subscription.

Print your photos

e 3

Unhide content

In the Music or TV app. click
Account > Account Settings. Navigate
to the "Downloads and Purchases”
section and click Manage next to
Hidden Purchases. Select the content
you want to unhide, then click Unhide.

e
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[l

Cancel it

On Magc, in System Preferences
click your Apple ID. Select Media &
Purchases and then click Manage next
to Subscriptions. Click Edit next to the
subscription and then Cancel. In i0S,
it's Settings > Apple ID > Subscriptions.

> BOOKS, PODCASTS AND MORE

The entertainment options continue

The Books app is the place to go to buy books to read or audiobooks to listen to.
When you launch the app, you'll see there are two stores, one for each type of
book. Browse the store you want, and when you find a book to buy, click the price.
If you listen to podcasts using Apple’s Podcasts app. you can sign up for premium
versions of some podcasts, which usually entitles you to extra episodes and ad-
free listening. Most offer a free trial. In Podcasts, click or tap Browse and look for
Explore Subscriptions to see all the podcasts that offer premium extras.

JAN 2023
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aASK

fs—.' EXPERT

ADVICE

b‘ Our resident genius solves
your Mac and iOS problems

Email Mac|Life at ask@maclife.com

TECH SUPPORT & TECHSPLANATIONS

macOS
malware
scans

UNTIL THE RELEASE of
Monterey 12.3 last March,
macOS had only limited
tools to tackle malware.
Its Malware Removal Tool
(MRT) scans your Mac
shortly after startup,

and XProtect checks apps
for signatures of known
malware when they’re
first run.

Over the last six
months this has changed
dramatically with the
arrival of XProtect
Remediator, posing as a
new XProtect app in the
Core Services folder on
your Mac’s Data volume.
Several times a day this
scans for telltale signs
of the troublesome and
versatile Trojan known as
DubRobber or XCSSET,
and checks daily for
others including Adload,
Pirrit, Trovi and
CloudMensis.

This new protection is
only available for
Catalina and later —
proof once again that
running the current, or
more recent, versions
of macOS brings the
best security.

74 | 3AN 2023

> No ARM Boot Camp

Why don’t Apple silicon Macs support Windows for ARM in Boot Camp?

In terms of hardware, Intel Macs are only
really a special build of PC, and getting them
to start in and run Microsoft Windows was
relatively straightforward. Although made a
bit more complicated with the addition of
the T2 chip, they have remained highly
compatible with other PCs.

Not only do Apple silicon Macs have a
completely different processor, but all the
supporting electronics in their chips are
different too. While the special versions of
Windows made for Microsoft’'s ARM-based
Surface touchscreen systems are built to
run on ARM processors, they're designed for

completely different irmware and
supporting hardware systems.

Apple silicon Macs have to start up from
their internal SSD, from which they prepare
to run macOS. There is a point in that
process that can be used to run another
operating system, like Asahi Linux, but for
that to work with Windows on ARM it would
require a lot of changes. Unless Microsoft
decides to build in support for Apple's
hardware, the only way to run Windows on
Apple siliconis in a virtual machine, as that
can provide Windows and Linux with virtual
devices in software.

Windows 11
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Unless Microsoft decides to port Windows for ARM to Apple silicon, a virtual machine is the only option.

Image rights: The Asahi Linux Contributors.



Tech Support & Techsplanations

Get official documentation at support.apple.com | Get help with hardware at support.apple.com/repair

> Secure your devices

Which security protection should | use on my iPhone and iPad?

Apple intends that users shouldn't need
any additional security protection for
their devices. Central to that is the
provision of apps only through its App < Settings Advanced
Store, where Apple can ensure that
none are malicious. When run in iOS or
iPadQOS, they're constrained to a

“sandbox” intended to block them from DNS Server(s)
any malicious behavior.

Defenses also rely on ensuring you Fast WiFi Switching
update your devices promptly when

Apple releases new versions of iOS and Transport Protocol
iPadQS, which invariably contain
essential fixes to their security.

However, some sophisticated
spyware has been able to break through
these protections, although unless
you're likely to be targeted by attacks
from state-sponsored security
agencies, you're almost certainly never
going to be affected. If you do think
that's a realistic risk, however, you need
advice from a security professional.

More likely are the increasing number Share VPN Configuration
of unwanted apps that try to steal
private information, potentially
unwanted programs (PUPs), and
phishing attacks from websites, text Abbreviated Totals
and email messages. The best defense
against those isn't any additional
software, but your behavior.

Because iOS and iPadOS are locked
down, it's not possible to create Software firewall apps can help keep devices secure,
software with general security protection but wise behavior is the most important protection.
features in the way that can be done for
macO0S, and you should be extremely

suspicious of apps claiming otherwise. You having to subscribe to its VPN service. Those
can get a useful free scam and ad blocker in can be useful adjuncts, but keeping up to
Malwarebytes Mobile Security, and Guardian date and selecting apps carefully are far
provides a free software firewall without more important.

Image rights: Apple Inc.

Quick-fire
questions
& answers

HOW SHOULD | REPORTA
FRAUDULENT MESSAGE?
Any email, text or message
that looks suspicious and
claims to be from Apple
should be forwarded to
reportphishing@apple.com.
Those claiming to be from
named banks or official
services should likewise be
reported to the organisation
concerned. In Messages, you
can tap Report Junk for any
others. Further details are at
apple.co/3KPehvn.

HOW TO CHANGE

TEXT SIZE WHEN

I'M USING AN APP?

The simplest way is to add
the Text Size control to the
Control Center, in Settings >
Control Center. Then when
you're using the app, to
increase its text size, drag
from the top right to open
Control Center, tap the Text
Size control, and adjust the
setting for that app.

JAN 2023
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@ Ask

DO LOGITECH

MICE WORK WITH
UNIVERSAL CONTROL?
Recent wireless models
should work fine with
Options+ software. Logitech
warns that configurations
made in Options+ apply only
to the Mac on which those
are set. Universal Control
also overrides the Flow
feature if that has been set
up. If you prefer Flow, disable
Universal Control first.

DOES A STUDIO DISPLAY
WORK FROM ATB3 DOCK?
Provided the Thunderbolt 3
dock is Mac compatible, it
should drive a Studio Display
well. When Apple releases
“firmware” updates for the
display, your Mac should
recognize and install them.
The only quirk is that the
display isn't then listed in the
Graphics/Displays items in
System Info, but appears in
the Thunderbolt section.
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Every bootable copy of mac0S on Apple silicon requires an “owner”, assigned at the start of installation.

> Make a bootable external drive

How can | make an external bootable clone of the internal SSD in my M1 MacBook
Pro? I've tried using Carbon Copy Cloner, but just get an error 108. Is this impossible

on Apple silicon Macs?

Apple silicon Macs are designed to be able
to start up from external drives, but
creating them using cloning techniques is
no longer a reliable option, and is not
recommended. Instead, it's much better to
install macOS on them using Apple’s full
installer app. This is because of the way
macOS always starts up from the internal
SSD in an Apple silicon Mac, and how
external boot disks require secure
ownership — but unlike T2 models they
don't need any change in startup security,
in Recovery mode.

Start by formatting the external drive
in APES, then either download and run the
current macOS installer from the App Store,
or start up in Recovery and go to Install

> A Studio Display never closes

Although I love the image and adjustable stand of my Studio Display, it behaves quite oddly at times.
It never turns off, so whenever | connect my MacBook Pro to it, the notebook powers up,
and it keeps attached disks running even when it’s off. How can | take control of it?

Apple’s Studio Display is designed to be

USB-C ports. Currently there's no way

macOS there. Opt to install to your external
SSD, and leave the process to complete.
You'll be asked to select a user to make the
owner of the new startup volume, and
should then copy the account settings for
that user when invited.

At the end of the first phase of
installation, time will stand still when the
installer says there's only a minute or so
remaining. Give it ample time, and your Mac
will then go through the usual sequence of
black screens and progress bars as the
installation completes.

Once those are done, your Mac should
start up from your external drive, and will
complete personalization, setup, and two-
factor authentication.

you shut your Mac down, the Studio

Display does power down the USB-C
ports for a few seconds before powering
them back up. With a spinning hard disk
connected, it would first be spun down,
then spun back up, generally considered
to be the events that contribute most to
mechanical wear, thus to disk failure.

always on when it's provided with to change those behaviors, apart from
supplying it with power from a switched
wall power and turning that off.

For solid-state peripherals, this
shouldn’t be any problem. However,
it doesn't appear that it will do

rotating hard disks any favours. When

power, and has no off button at all. This
has some unexpected side-effects, in
that it will immediately power on
notebooks when you connect it to them
by Thunderbolt, as it does to any
peripherals connected to its three
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AP WHY WON'T MY EXTERNAL
Sharing & Permssions- DVD DRIVE WORKIN
Show Time Machine in menu bar MONTEREY?
Optical drives should work
When Time Machine creates a well in Monterey. Some older

new backup store, it now uses

’ models may not be
APES format, preventing you

e ingor oy compatible, though, and it's
worth checking whether
° updates are available to
> Network quallty Zero help. Otherwise, once you
The 1TB external disk | keep my Time Machine backups on is almost full. How should | have confirmed that the
move them to a replacement 4TB disk, so | can use that for backup storage? cable isn't to blame, try a
modern drive.

This depends whether your current backup backups are built on snapshots, which WILL AUSB-C HUB WORK

store is a traditional HFS+ volume, or the can't be copied to another volume or drive. ON A MAC STUDIO (M1

more modern APFS. To discover which it is, When you start making backups to your MAX) FRONT PORT?

select that volume in the Finder and use the | new drive, Time Machine will probably insist Yes, if it's Mac compatible.

Get Info command in the File menu. In the it uses an APFS volume anyway. The best Beware, though: the front

top section, its kind should be Volume, and plan is to keep your existing backups as an USB-C ports share a

the format will either be Mac OS Extended archive. If you ever need to access them, maximum throughput of

or APFS (case-sensitive). they'll still be available through the Finder 10Gbps, so a couple of SSDs
Copying Time Machine backups from an rather than the Time Machine app. Then may work at slower than

HFS+ volume takes forever, is prone to start a new backup set on the APFS volume normal speeds. But for other

error, but can be done. Copying them from Time Machine will create for you on the devices a hub should

APFS currently isn't possible, as those replacement drive. be fine.

As the display has the full iOS from an
iPhone inside it, maybe Apple will
provide the user with some control over
this behavior in the future.

You may wish to avoid connecting spinning hard
disks to the USB-C ports on a Studio Display to
reduce their wear.

Image rights: Apple Inc.
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@ Ask

> Ordering your desktop

I like SSDs shown in custom order, but also want them to snap into place. How can | do that in Monterey?

You have two choices for displaying
items on the desktop: either use
Stacks and accept the order it places
them in, or you can choose to turn
Stacks off and position them in the
order you want. Click on the desktop

and uncheck Use Stacks in the View
menu. If the Sort By sub-menu is set
to Off, you can place them wherever
you want. Enabling Snap to Grid places
them regularly, but in custom order.
When you enable Use Stacks, they'll be

placed in order by name or another
sort option, and setting sort order to
None disables the stacks. Currently
there’s no way to lock items in place
without using Stacks or snapping
them to a grid.

With Stacks turned off, you can order the
items how you wish, and use Snap to Grid for a
regular layout.

HOW TO RECOVER

THE POINTER FROM
UNIVERSAL CONTROL?
Press Cmd+Opt+Ctrl+
[Delete] at the same time.
The pointer should reappear
on its original display, under
full control. You can also
connect a wireless mouse or
trackpad using its charging
cable, turning itinto a

USB device.

WHY WON'T MY

MACBOOK COMPACTA
SPARSE BUNDLE?
Probably because it's
running on battery.
Compacting takes time,
during which any loss of
power could destroy the
sparse bundle. macOS won't
start compacting on battery
power unless you override
that behavior using hdiutil’s
-batteryallowed option orin
the app using it.
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> Setting global preferences

| prefer the expanded Save window in all my apps. There used to be a way to set
that in a global preference, but does that still work in Monterey?

As recently as macOS Mojave, you could use
the two Terminal commands:

defaults write -g
NSNavPanelExpandedStateForSaveMode
-bool true
and

defaults write -g
NSNavPanelExpandedStateForSaveMode2
-bool true

to make the full and expanded version
of the Save window the default across all
apps. As far as we can tell, that's no longer a
global preference setting, but has to be
made for each individual app. The good
news is that you don't need to go into
Terminal or type in commands to do that. All
you have to do now is save one file from that
app. and in the process click on the disclose
button at the right of the Where pop-up, to
use the expanded form of the dialog. The
app should then use that until you choose

otherwise. Apple has removed many of
these global settings in more recent
versions of macQS, although as most were
undocumented they've been used
decreasingly anyway. Some global defaults
remain in Monterey, although no one seems
sure which still work. You can check
whether they already exist using a
command like:

defaults read -g
NSNavPanelExpandedStateForSaveMode

although note that non-existence
doesn’'t mean that the setting has gone.

Choosig_'t-i‘ie minimal Save window (left) or its
expanded version (right) is set for individual apps.

Image rights: Apple Inc.



> Migrating from a damaged Mac

I used a housekeeping utility to remove apps from my old Mac before switching to my new M1iMac.
It has gone too far, damaging some so | can't migrate. How can | restore them ready to migrate?

This is one of the dangers of these
utilities, and it's always best to do your
own housekeeping, erring on the side
of safety. You now have two choices:
use your backups to restore to your old

Mac before migrating it to the new one,

or use those backups to set your new
Mac up directly.

Using your direct route, start your
new iMac up without the backup drive
connected, personalize the Mac, and

set it up with a new user account,
ideally using the same short name as
your old Mac. Once it's up and running,
install any macOS software updates,
then connect your backup drive and
run Migration Assistant from the
Utilities folder. When it asks you what to
migrate from, select the latest backup
made before you performed any
housekeeping. When it asks you what

| you want to migrate from that backup.

take your time and ensure that you
select what's good to go across,

then ensure that it's migrated into your
fresh user account.

If you intend on keeping your old
Mac, you can start it up in Recovery
and either migrate or restore to that
from the same backup to return it to its
previous state. But by that time you'll
probably be content using your new
iMac instead.

Restore from [ime Machine

The best way to restore your
Mac from a recent backup is
to start it up in Recovery with
the backup store connected.

HOW TO REPORT A BUG IN MACOS
TO APPLE?

Draw up a clear description of the bug,
and how an engineer can reproduce it.
Before reporting, check with Apple
Support that it really is a bug, not a
misunderstanding. Then head over to
apple.com/feedback, click on macOS
in the macOS Apps section, and
complete the form.

HOW TO FORCE SPOTLIGHT TO RE-
INDEX A DISK?

Open the Spotlight pane and select
Privacy. Click on the “+" at the lower
left and select the volumes on that
disk to add them to that list. Close the
pane and wait a minute, open it again,
select those volumes and remove
them using the “~" tool. Re-indexing
appears in Activity Monitor's CPU tab.

EMAIL: ask@maclife.com
SHARE WITH US! FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

MaclLifes®
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Use Mail Merge in Pages

REQUIRES

Mac (running Big Sur

or later), iPhone (i0S 14
or later), or iPad (iPad0S
14 or later)

YOU WILL LEARN
How to merge contact
details with documents
in Pages

IT WILL TAKE
45 minutes

THE ABILITY TO merge contact
details with documents has
, | been missing from Pages for
almost a decade. But now,
the ability to send the same letter to lots
of different people — without having to
create a new document manually and then
copy and paste into each one — is back in
Pages 12.1.

Mail Merge is one of those features that
if you need it, it’s indispensable and if you
don’t, you probably haven’t even noticed
it was missing. However, for a tool that
aims to be an alternative to the likes of

The merging options

CONTACTS OR
NUMBERS

You can choose to merge
data from a group in the
Contacts app or from

a Numbers spreadsheet.

B

PLACEHOLDERS IN
TEMPLATES

Letter templates in

Pages already feature
placeholders for merge
fields, but you can add
them to any document.

JAN 2023

KENNY HEMPHILL

Mail Merge
P =
artp BT
Contacts Spraadshoel
=

Group:  All Contacts
erge Field ':':-‘;'-'11.4!..": Wikh
Addrass (home] {Sandar] Addrezs (homa)
Fhione [mobile] [Sender) Phone (mobile)
Email {home) (Sender] Email {home)
Full Narme [Sander] Full Name
Fusll Harnm Full Name
Company Coampany
Acdrass (wor| Address (work]

Substitute closest match

534 Records Prewiew — Canesed

Microsoft Word, it was a glaring omission
and meant relying on workarounds using
AppleScript to fill the gap.

Mail Merge in Pages 12.1 enables you to
pull in contacts’ details from the Contacts
app or from a Numbers spreadsheet and
use them to replace placeholders in any
document. It’s worth noting that the
spreadsheet has to be in Numbers format,
it won’t work with Excel or CSV files.
We’ll show you how to prepare your
contacts in Contacts and Numbers, and
how to merge them in your Pages
documents. KENNY HEMPHILL

MATCH THE FIELDS
Once you've chosen the
source of the merge data,
you need to tell Pages how
to match the fields.

& €3

: | PREVIEW
. THE LETTER

Before you click Merge, you
can preview how the data
from your source will be
filled in on the letter.



How to do anything on your Mac, iPhone & iPad

HOW TO Merge contacts in Pages

o Create a group

In Contacts on Mac, click File >
New Group, give it a name and drag
contacts onto it in the sidebar. You
can't create groups in i0S and iPadOS,
but in Contacts on icloud.com, click
“+" and New Group to create one.
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Create a letter

In any version of Pages, choose
a letter template in the Template
Chooser and click or tap Create to
create a new document. Type the
content of the letter, leaving the
recipient’s details blank.

TR T e

o Merge spreadsheet

Click Document > Mail Merge >
Merge. Choose "Add from
Spreadsheet’, navigate to the Numbers
file and click Open. If the spreadsheet
contains multiple tables, make sure the
table you want is selected.

Image rights: Apple Inc.

A Numbers source

In Numbers on Mac, iOS or
iPadQS, create a new document and
add a table to it. Give the column
headers the names of the fields you
want to use in your document, such as
first name, last name, street, postcode.

g hE s

B Mail Merge on Mac

In the right-hand sidebar, click
on Document and then the Mail Merge
button at the bottom of the window.
Select Merge in the window that opens
and then choose your new Contacts
group from the menu. Click Merge.

o Finish up
You'll see two columns, Merge

Field and Populate With. Click Select in
the latter and choose which column
from your spreadsheet you want to use
to populate that field. Or, click Don't
Use. When you're done, click Merge.

B Populate table

Once you've created the table,
add the details for the contacts you
want to merge with your Pages
document. You can type them
manually or copy and paste. Save the
document to iCloud when you're done.
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o Merge on an iPad

In Edit mode, tap the “." icon
and then Mail Merge. Tap Merge, then
tap Contact under Sender and choose
a sender. Tap Contacts under Recipient
Information and choose the group you
created earlier. Tap Merge.
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Add fields

Letter templates have fields
already in position. To add fields to any
document, go to Document > Mail
Merge and position the cursor where
you want to add it. Click Add Merge
Field and choose from the menu.

JAN 2023
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Super-strength passwords

1Password 8 for Mac keeps all your precious data under lock and key

REQUIRES

1Password 8 for Mac,

mac0S 10.15 or later

YOU WILL LEARN
How to secure logins,
sensitive info, private notes,
and more

@

IT WILL TAKE
10 minutes

slog. No wonder so many people reuse
“Passwordi123” for everything.

But there’s a better way — use a
password manager. 1Password is one of
the best there is, and it can generate and
save strong, unique passwords so you
never even need to think about them. All
you need to remember is a master
password — and if you have an Apple

WE ALL KNOW we need to use
strong, unique passwords for
our accounts, but doing this
for every single login is a

HOW TO Master the basics

5 Cantinies with Goagls

B Continus with Apple

g ‘

0
.
o Frivgir] Fassvan

B Er

arcount? Sign e

Bon't hurse an

Autofill

Install the 1Password Safari
extension. On a website where you
have a saved login, click the
1Password icon in the form field, then
choose your login. Its username and
password will be automatically filled in.

JAN 2023
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Quick Access

Press Shift+Cmd+Spacebar to
open 1Password’s Quick Access bar.
This works like Spotlight — search for a
login and the entry appears. You can
copy the password, autofill it if you're
on the right website, and more.

Watch, you can unlock the app with that
instead. It even goes beyond passwords.
The app can save your addresses,
vaccination dates, driver’s licence, private
notes, and more. It even works with SSH
keys and one-time passcodes. That makes
it a one-stop shop for all the info you
want to keep safe.

In this tutorial, we’ll show you how to
use 1Password 8 and its Safari extension
(which you should install before starting)
to ramp up your login security. It’s way
easier to use than you think. ALEX BLAKE

B Autofill in apps

Password autofill also works in
apps. Press Shift+Cmd+Spacebar and
Quick Access should show the app's
login. Press Shift+Return to autofill it.
1Password even clicks the Sign In
button for youl

Image rights: 1Password.
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HOW TO Use 1Password in Safari

o View a login
When you click the 1Password

button in Safari, it will show your
current website’s login (if there is one
saved). Click Autofill to enter its info, or
click the “." button to edit the login,
add it to favorites, and more.

HOW TO Go deeper

= e e o]

9 Browse your info

On the left, click Suggestions.
Here you can browse saved
information in different categories,
such as credit cards and your personal
details. You can view your favorites and
all your saved items at once.

In T

Create a password

Estiuar i priaiomtorif yoina ezl Bl s ool iy yonad
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B Save a new login

When you register for a new
website account, 1Password can save
the details. When you get to the
password field, click Use Suggested
Password. Add any extra details in the
pop-up window, then click Save.
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The Watchtower

In the sidebar, click Watchtower.
This rates your passwords and shows
suggestions to improve. Click Show
Items next to the suggestions; choose
an item in the list, then follow the on-
screen instructions to secure it.

Enter your
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9 Apple Watch unlock

First, ensure Apple Watch
unlock is enabled in System
Preferences > Security & Privacy >
General. Then click 1Password >
Preferences > Security and tick the
checkbox next to Apple Watch.

> 1PASSWORD 8 ON i0S

B Not just passwords
1Password 8 can store more
than just email addresses and
passwords. Click New Item in the top
right; there are options for driver’s
licences, passports, medical records,
payment cards, and more.

Working together with the Mac app

1Password 8 also has an iOS app. Mac features like Watchtower are present and
accounted for, as are favorites and collections. As well as syncing all your logins
across your devices, it also has some i0S-specific features. For example, the new
version of the app lets you show, hide, and rearrange home screen items, making
it easy to find what you need. And you can unlock the app using Face ID, giving
you an incredibly secure way to keep your logins safe. Use it in tandem with the
Mac app so you always have your saved items to hand.

Image rights: 1Password.
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@ Create

Organize
your day

Overhaul your schedule

IEOs=R0%a BE- - B u0¥ s ull

and get organized like

never before

REQUIRES
Calendars (from readdle.
com), mac0S 11 or later,
optional subscription

YOU WILL LEARN
To manage events with this
Readdle app

IT WILL TAKE
10 minutes

= APPLE'S CALENDAR APP is fine
— for managing your day-to—day
Spme  appointments, but it’s no
!l" great shakes. Swap it out for
the (similarly named) Calendars from
Readdle, though, and you’ll have a more
modern way to keep track of everything.
Calendars boasts a plethora of power
tools, from natural language entry to
integrated reminders. It syncs across Mac,
iPhone, iPad and Apple Watch, works with
popular video—calling apps like Zoom and
Google Meet, and lets you create new

HOW TO Manage your daily tasks with Calendars

Add accaunt

events with Siri. Got events that you
frequently add to your calendar?
Calendars lets you save time with its
Shortcuts feature. These work like
templates that are stored in the sidebar
and can be assigned quickly and easily
whenever you need them.

Calendars is free to use but has a
subscription that unlocks its most
interesting features, which we’ll cover
here. Once you start using this app, you’ll
wonder how you got by with Apple’s
Calendar app. ALEX BLAKE

e i e

5 MU [
Wy 0 W

W @ Exchange
& Outiock
Sibieilied & Cloud
Cancel -
o Add your accounts Hide calendars
During the set-up process you Click the three-line icon in the

can add calendar accounts from iCloud,
Google, Outlook, and more. You can also
add local calendars. To add another one
later, click Calendars > Add Account and
follow the on-screen prompts.

JAN 2023

top-left corner to see a list of your
calendar accounts. Click the checkboxes

by each calendar to add or remove them.

You can change calendar colors by
clicking Edit Calendars at the bottom.

Create an event

Click the blue “+" in the top-right
corner to create a new event. Enteran
event title, date and time, assignitto a
calendar, and pick from extra options like
attendees and location. When you're
done, click Save.

Image rights: Readdle Inc.
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o Language input
Calendars knows natural
language. When creating an event, type
“Meeting Tuesday at 4pm” and Calendars
will schedule the event at the correct
time. It understands contact names,
locations, times, and more.

o The day today

Click Day to see what's coming
up on your plan today. At the top is the
date, the weather, and a list of your tasks
and all-day events. Underneath is your
schedule, with each event blocked out
for its planned duration.
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10 Add a reminder
At the top of the reminders list,
click "Add a new task” and start typing.
This is a quick way to add reminders
without having to navigate to the Tasks
tab. When you're done, you can drag
the reminder to your calendar.

Image rights: Readdle Inc.
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9 Video-calling apps

When creating an event, click Add

Video Call and select an app from the list.

Calendars will then automatically create
a meeting link with a password for your
video call. You might need to log into
the video app first.
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Drag and drop

@ (Calendars has some neat time-
saving features. In any view you can drag
and drop a calendar event to move itto a
new time. That's quicker than clicking
each event, manually changing the time,
and then saving.

Shortcuts

:} Plans

Today Shortcuts

mrol
Hascut

h Walk
o Family time
Croathe Tuna

Wiorked

Shortcuts

In the top right, click Shortcuts >
Create a new one. Enter the shortcut's
name and set an emoji and event
duration, if you like. Now just drag
the shortcut from this menu on to

your calendar whenever you need it.

How to do anything on your Mac, iPhone & iPad

. Upgoming

..........

Views and tasks
Change the view using the Day,
Week, or Month buttons at the top
to zoom in or out of your schedule.
If you've connected Calendars to a
reminders app like Google Tasks, your
to-dos will be stored in the Tasks tab.

v i
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o Make some plans

On the right, click Plans to see a
list of your reminders, which you can
drag on to the calendar. Click the arrow
by Today to view your tasks inbox,
upcoming to-dos, completed tasks, or to
filter by each reminder list.

® Soccergame

FRET Sat 1 Aaig
B ] T

i ek

New color scheme

By default, events take the color
of the calendar they're assigned to. But
you can set a new color (just once or
for all future events if it repeats) by
selecting the event, then clicking Edit
and choosing a new shade.

JAN 2023
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Customize your Lock Screen

Make your iIPhone your own with cool wallpapers and widgets in i0S 16

REQUIRES
i0S or iPad0S 16

YOU WILL LEARN
How to customize your Lock
Screen in i0S 16

IT WILL TAKE
30 minutes

=

GENIUS TIP

Go to Settings >
Notifications to show
notifications as a stack, a
list, or hidden with just
the number of unread
ones displayed.

JAN 2023

THERE ARE A ton of new
features in iOS 16, but one that
is likely to see more use than
most is the ability to
customize your Lock Screen. Whereas
you’ve long been able to change the photo
or image and have some control over the
notifications that appear, you can’t
do much else. In iOS 16, all that changes.
Wallpaper options now go much
further. You can choose from the new

& 23°

Mostly Cloudy
H:23° L:14°

Widgets on the Lock Screen enable you to see calendar
events, reminders, activity stats and more with just
a glance at your phone.

People category, after which iOS will show
you photos of people from your Photos
Library that it thinks would work well as a
wallpaper. In some cases, a masking
effect will place the clock partially behind
the subject but in front of the background.

There are new Weather and Astronomy
wallpapers that are similar to the
equivalent Apple Watch faces and change
throughout the day, and there’s even an
option to use emojis as your wallpaper, if
you must. You can also alter the font and
color of the clock, and apply photo effects
to wallpaper.

Perhaps the most useful of all are the
new widgets that enable you to see things
like upcoming calendar events, your
activity status, battery levels for your
devices and current weather right on your
Lock Screen.

Notifications have also been improved
and now slide up from the bottom of the
screen, and new Live Activities enable you
to easily keep track of scores from sports
events, food delivery updates and Uber
journeys without leaving the Lock Screen.
KENNY HEMPHILL
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HOW TO Make a personalized Lock Screen
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o Choose wallpaper

Tap and hold on the Lock
Screen and tap the “+". Swipe up to
scroll through the sections of different
wallpapers, including Suggested
Photos. If you see one you like, tap it,
then tap Add to select it.

12 1212 ¥I2

12 12 12 (12)
©

Customize clock

In the customization screen,
after choosing a wallpaper, tap the
clock. Tap one of the font options and
one of the color options below. If you
select the globe, you can change the

numerals to Arabic Indic or Devanagari.

Depth Effect

Low Key

v High Key

p Edit portraits

If you choose a photo taken in
Portrait mode as your Lock Screen
photo, swipe through options such as
Studio and Color Wash. Tap “." to
switch between Low Key and High Key
or change the color of a color wash.

Image rights: Apple Inc.
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o Make your own

If none of the suggestions
appeal to you, tap Photos at the top of
the screen and either scroll through
your photos, search for one, or tap
Albums to choose an album to look
through. Tap a photo you like.

-~ 220
Partly Cloudy
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B Add widgets

In the same customisation
screen, tap Add Widgets, or if there are
widgets already there, tap them. Tap
“~"to remove a widget and then tap a
widget to add it from the Add Widgets
drawer. Tap “X" then Add to finish.

[ Do Not Disturb
- Personal
— Sleep

Choose a Focus

Long press the Lock Screen and
tap Focus. Choose a focus from the
menu, or you can tap Focus Settings to
edit the settings of an existing focus or
create a new one. Tap the “X" then the
Lock Screen to finish.

v Depth Effect

Style Colour...

B Edit photo
Swipe left over the screen to

see the different photo filter options. To
see more options, such as Depth Effect
if it's available, tap the “." icon. Use two
fingers to unpinch to zoom in and crop

the photo. When you're happy, tap Add.

-: Calendar

o Change top widget
There's another space for
widgets, above the clock. To change it
on a wallpaper, choose Customise and
tap the widget. Swipe up over the list
to see them all and tap one to choose
it. Tap “X" then Add to confirm.

Customise Customisa

New Home Screen
When you create a new Lock
Screen, i0S 16 changes your Home
Screen wallpaper too. To choose a
different Home Screen, go to Settings
> Wallpaper and tap Customise under
the Home Screen image.
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Mum & Dad

Okay

Here's the website

SharePlay
Wha by Fire (From "Bad
Sisters™) « PJ Harvey & Tim

Waiting for others

=

e

Hey Deb! Want to listen to this
with me?

This track is awesome, thanks

Yeah, it's fantastic, isn't it?

Great series too!

Tweak messages ini0OS 16

Whether you need to edit, unsend, or host a SharePlay, here's how

REQUIRES
i0S 16 or iPad0S 16

YOU WILL LEARN
How to use the

new features in the
Messages app

IT WILL TAKE
30 minutes

=

GENIUS TIP

You can now report SMS
messages as junk, as well
as iMessage. However, it's

only currently available

with two US carriers.

tn aid Roport Jurn
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MESSAGES HAS GRADUALLY
been catching up with apps
like WhatsApp and Microsoft
Teams, and in i0S 16 and
iPadOS 16, it gets some of its most useful
additions yet.

Until now, if you sent an angry message
to your boss, there was nothing you could
do except wait for the fallout. Now, you
can unsend the message and they won’t
know anything about it. Alternatively, you
can edit the message — although, be
warned: your boss will be able to see the

edits you have made. Messages also joins
the SharePlay party. When SharePlay first
launched, you could only use it while you
were on a FaceTime call. Now, you can use
it in Messages, too.

You have long been able to share files
in Messages, but now when you share a
document and collaborate on it, you will
be able to see in the Messages thread
when someone else in the conversation
edits the file. Plus, you can send messages
directly from the app in which you’re
working. KENNY HEMPHILL

HOW TO Edit, unsend, and more

v & ¥ W0 v ?

You can now unsend messages in
i0S 16

Reply &K

Undo Send

Edit =5

o Unsend a message

Both sender and receiver need to be
using i0S 16, iPadOS 16, or macOS Ventura. Tap
and hold on the message and choose Undo
Send from the menu. The message will
disappear from the thread on all devices.

v & ® W o ?

You can also edit messages in i0S 16,
as long as the other person is also

using i0S 16 iPadOS 16 or macOS
Ventura

Reply A

Undo Send

9 Edit a message

As for editing, both parties need to be
using a compatible version of Messages on
iPhone, iPad, Watch or Mac. Tap and hold on
the message until the menu appears, tap Edit,
make changes and tap the blue checkmark.

Image rights: Apple Inc.



Recently Deleted Done

Specsavers

o

Recover and restore

Deleted messages are now moved to a
Recently Deleted section in Messages. In the
main Messages screen, tap Edit at the top-left
corner and then Recently Deleted to see them.
Tap a message then tap Recover to restore it.

+r QO0ODOO = ¢
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¢

9 Send an audio message
Previously, tapping the microphone in
the text box enabled you to send an audio
message. Now, you need to tap the app icon
beneath the text box, tap the audio wave, then
tap the mic to start recording your message.

Share

.

Export

By

Print

@

@ Screen View

Collaborate with others

Collaboration works in Apple apps and
some third-party apps. Tap Collaborate in the
toolbar or the Share icon. Choose Messages
and select the options for the document.
Type the contact'’s details and tap Send.

Image rights: Apple Inc.
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Pin b8
Mark as Unread &
Hide Alerts B
Delete Tl

Mark as unread

You can mark conversations as unread,

though not individual messages. Tap on a
conversation thread in the main Messages
screen and tap “Mark as Unread”. A blue
dot will then appear next to the message.

t=ntag. |
Wordle 442 4/6
IIIII [
ﬂ This is a dictated messagd o

o Dictate a message

Dictation has improved in Messages.
Tap the microphone at the right of the text
window. Start dictating. When you're done, tap
the microphone in the keyboard. You can add
emoji, edit the text, or send the message as is.

Download (O]
Add to a Playlist... L
Play Next =
Play Last =
Share Album... M
SharePlay [

o Use SharePlay

Navigate to the app from which you
want to watch or listen, such as Music. Tap the
“." button. Tap SharePlay. Pick a contact and
tap Messages to start sharing. Both parties
must have an account with the service to join.

JARGON BUSTER

SharePlay enables you to
watch TV shows/movies or
listen to music with friends,
and playback is synced on
everyone's device.

=

GENIUS TIP

The joy of syncing: you can
send a message on one
device and unsend or edit
on another, for up to 15
minutes after sending it.

e pinig 2 edil 1) messce after |
annd A biremme | can

Raply <
Unoio S -]
Fit o

Copy (]
Trunsase i
Wiom e
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WHAT IS
AVAXHOME?




the biggest Internet portal,
providing you various content:
B brand new books, trending movies,
fresh magazines, hot games,

recent software, latest music releases.

Unlimited satisfaction one low price
Cheap constant access to piping hot media
Protect your downloadings from Big brother

Safer, than torrent-trackers

18 years of seamless operation and our users' satisfaction

All languages
Brand new content

One site

AvaxHome - Your End Place

We have everything for all of your needs. Just open https://avxlive.icu
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Master multitasking on iPad

Do more with your iPad by running multiple apps side by side

REQUIRES
An M1-powered iPad for
Stage Manager, iPad0S 16

YOU WILL LEARN
The different ways to
multitask on iPad

IT WILL TAKE
10 minutes

=

GENIUS TIP

Stage Manager works best
on iPads that are connected
to external displays,
especially larger displays
that have lots of room

for multitasking.

JAN 2023

EVER SINCE THE very first iPad

was unveiled way back in 2010,
L | users have demanded Mac-
W style multitasking — and
Apple has tried various ways to deliver it,
with mixed results. In addition to the two
existing ways to multitask, Slide Over and
Split View, some recent iPad Air and iPad
Pro models now have a third option
available: Stage Manager.

Stage Manager is in iPadOS 16 (and
macOS Ventura), and it’s the most
Mac-like interface Apple has used on the
iPad. It enables you to run several apps in
their own resizable windows, just like you
would on a Mac desktop, and you can
switch between them by tapping. It feels
very Mac-like, especially if you have an
external keyboard and mouse.

Stage Manager isn’t for everyone,
though. For starters it only works on
Mi-powered iPads, which means owners
of older iPads (and even the new iPad 10th
gen) won’t benefit from the feature.

You can find out more about iPadOS 16,
and get a better insight into all the new

The recently used apps in the left-hand side look nice
but take up room; you can disable them in Settings.

aspects of Stage Manager on the iPad by
heading over to our main feature on page
12 (if you’ve not looked there already).

In this tutorial, we’ll look at the three
different ways you can organize your apps
for multitasking on your iPad: Split View,
which as you’d expect splits the screen
between two apps; Slide Over, where one
app floats above another; and the new
Stage Manager. CARRIE MARSHALL

Image rights: Apple Inc.



o Split the view

Tap on the “." at the very top of
the app you're currently using and tap
Split View. The app will move to the
side and your Home Screen appears;
tap the app you want to launch. You
can adjust the split by dragging it.

o Stage Manager

To move into Stage Manager,
pull down from the top right of the
screen to display your iPad’s Control
Centre. You should now see the Stage
Manager toggle; here it's the very
bottom icon. Tap it to continue.

o Adjust and switch

Here we've made Apple Maps
take up the lion’s share of the screen
space, and we can switch between our
two apps simply by tapping on the one
we want. As with Slide Over and

Split View you can drag between apps.

Image rights: Apple Inc.

How to do anything on your Mac, iPhone & iPad

HOW TO View multiple apps on iPad

Slide it over

If you want your current app to
take up most of the available screen
space, use Slide Over instead of Split
View. This brings up the second app in
a narrower panel. As with Split View
you can drag and drop between apps.

B Open your first app

Open an app and you'll see that
now, it doesn't open full screen.
Instead it leaves room for other recent
apps in the column at the left. To add
another app, tap the "." at the top of

the app and then Add Another Window.

o Drag between apps

Simply highlight the text or
image you want to copy from the first
app, then press and hold, dragging it
over its destination. Here we're
dragging from a Wikipedia page in
Safari to an open doc in Pages.

T

s

0O i

B Toggle on
On an iPad with an M1

processor, you can also use the new
Stage Manager feature in iPadOS 16. To
do that, you'll need to switch it on first,
S0 go to Settings > Home Screen &
Multitasking > Stage Manager.

o Open your next app

Tap on the app you want to
open next and you should now see the
screen looking like this. You'll see there
are grab handles at the lower right and
lower left of the two app windows; drag
them to resize the app’s window.

& A

cogs
o=

=as
888
000
2000

o Leave the stage

You can go back to normal,
single-app mode by tapping the “." at
the top of an open app and selecting
Zoom. Or, pull down Control Centre
from the top right and tap on the Stage
Manager toggle to switch it off again.
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| scheduled your
event with Kenny
Martin for tomorrow
from 19:00 to 20:00,

CALENDAR

Dinner

Create events on € Watch

REQUIRES
watch0S 9

YOU WILL LEARN
How to create
new calendar

events in watch0S

IT WILL TAKE
b minutes

WHEN IT COMES to OS updates,
watchOS gets the least
attention. This year is no
exception: there’s no watchOS
equivalent to Stage Manager on iPad or to
the iPhone’s new ability to cut pets and
people out of photos. But that doesn’t
mean watchOS updates aren’t important.
watchOS 9 makes your Apple Watch
more customizable, more useful and more
powerful than before, and while many of
the improvements may seem far from

Set up an event on Apple Watch

Done

+ New Event

) Up Next

— Day

i= List

@ Open the calendar
When you open the Calendar app

r' 1,
|

10:21

Cancel

Dinner L |
inner” Dinners ® =
gwer tyuiop
asdfghijk./

S zxevbnm@E

SPACE

® )

-

N Add a title

=

S First we need to add a title. If you

headline—grabbing they will actually save
you a lot of time in the months to come.

The updates to the Watch Calendar app
are a great example of that; you can now
navigate more quickly to specific days and
weeks, and it has the same event creation
options as the iPhone app — so you can
create new events, add them to specific
calendars, send invitations to other
attendees and more. It’s the sort of thing
we like about updates; it all makes life a
little easier. CARRIE MARSHALL

i

&) Set the times

fodt!

» By default, new Calendar events

on your Apple Watch, you'll see three
different view options to show your
upcoming events, and a big red New
Event button. Tap on New Event to add
your new calendar item.

JAN 2023

have a crowded schedule it's wise to use
really descriptive names, but our event
here is just catching up with a friend so
we'll type “dinner”. You can use the
microphone if you prefer.

are all-day events, but you can quickly
change that by tapping on the event
start time and using the Digital Crown to
specify when the event will start.

Do the same for its finish time.



I Friends

I Family stuff
Family (shared])
I School dates

Wark

@ Choose a calendar
W We use multiple calendars to keep
track of different things — personal
events, work deadlines, and so on. You
can't create new calendars on the Watch
but you can assign new events to
calendars you've already created.

Add

Cancel

@ Add a note

W The final step is to add a note, if
you want to include one — we use this
field to remind us of relevant information
such as who paid the bill the last time or
what items we need to remember to take
along. Tap on Add when you're finished.

Dinner
19:00-=20:00

l Friends

Carrie Marshall

# Confirmiit's correct
2 Siri doesn't show any additional
details about your new event such as the

calendar name or invited contacts in its
confirmation screen, but if you check the
new entry in the calendar app you'll see
that it's stored those settings too.

10:22

+ Add Invitees

Louise Blain

If your event involves others, you
can send them calendar invites from the
New Event screen on your Watch. All you
need to do is pick the appropriate
contact(s). If you change or delete the
event they'll be notified automatically.

Add invitees

Create an event

my friends calendar
for 7 pm on Wednes
day dinner wilh
Kenny Martin

£ Speak to Siri

D If all that typing seems a bit
unnecessary, you can use Siri. Simply
press and hold the Digital Crown and tell
Siri what you want, for example “create
an event in my (calendar name) calendar
on (date and time) with (contact name)”.

'Kids @ flat' is also

scheduled for this time

¢ Clear any conflict

=" In anice touch, Siri will warn you if
your new event conflicts with any other
event in your calendar. If you dismiss the
warning as we've done here, that conflict
information will still be visible in the
Calendar entry for those events.

None

At time of event

5 minutes before

10 minutes befare

@ Setan alert

2 One of the most useful Calendar
features is its ability to alert you of an
upcoming event so there's enough time
to prepare for it. Simply tap on Alert and
tell your Apple Watch how far in advance
you want to be reminded of this event.

| scheduled your
event with Kenny
Martin for tomorrow
from 19:00 to 20:00.

CALENDAR

Dinner

9 See new event

7 Provided Siri hasn't misheard you
— something that happens occasionally
in noisier environments or if you have
similarly named contacts — you should
see a screen like this, confirming the new
event you've just asked Siri to create.

TUEG

= 10:40

6 Sep—7Sep
Kids @ flat

o & ()

L ]

™ Use a complication

2% Many Apple Watch faces can
include a Calendar view as a compilation
of upcoming events. Here we've added
the Calendar view to the centre of the
colorful watchQOS 9 Modular watch face
so we know what we've got planned.

JAN 2023

93



Make dynamic presentations

Give your animated presentations extra pizzazz in Keynote 121

REQUIRES
mac0S 11.0 or later, iPad0S
14 or later, Keynote 12.1

YOU WILL LEARN
How to use

dynamic background
animations in Keynote

IT WILL TAKE
30 minutes

DYNAMIC BACKGROUNDS ARE a
new feature introduced with
Keynote 12.1, which was
released in June of this year. If
you’re not up to date with the latest
version of Keynote, make sure you update
before starting this guide. You must be
running macOS 11.0 (Big Sur) or later, or
iPadOS 14 or later if you’re using an iPad.
The new dynamic backgrounds feature
lets you add subtle motion to your
Keynote slides, which move continuously
as you view. If you use the same dynamic
background on consecutive slides, the

HOW TO Get started with a dynamic background

A YACHT IN MONACO

Create document

Here we're going to edit a

s a0

AYACHT IN MONACO

&

9 Open the sidebars

If the left sidebar isn't visible, click

dynamic background into a presentation
we've already made, but the guide works
just as well when designing from
scratch. First, open the document in
guestion (or start a new one).

94 | JAN 2023

View (top left) and select Navigator. In
the top-right corner of the screen, click
on the Format icon to open the right-
hand sidebar. In the left-hand sidebar,
click on the slide you want to edit.

animation continues to play without
interruption as you move between them.
It’s also worth noting that these
animations are generated procedurally, so
they don’t have too much of an effect on
the size of your Keynote file.

Keynote’s dynamic backgrounds can do
much to make your keynote presentations
more interesting, but as always, don’t
overdo them. Sometimes, less is more.
Too many differing animated backgrounds
can look messy and may become
overwhelming for people trying to follow
the slides. IAN OSBORNE

T W O FNRT B e

B Select background

If you currently have a text or
picture box selected, click on the slide’s
background to select that instead. In the
right-hand sidebar, look for the section
titled “Background”, and its Standard
and Dynamic tabs.

Image rights: Apple Inc.



o Add the background

Click the Dynamic tab, and
choose a dynamic background from
those on offer. You can use the chevrons
on either side of the six backgrounds
shown in the sidebar to navigate through
the full range.

[Sm——— . @
Colsry
L] " ER

—

Other controls

The other dynamic background
controls differ according to which
background you've chosen. Here we
have Speed, Amplitude, Wavelength and
Focus. Experiment with them using the
slider bars until you find what works.

Preview and Colors

The Preview Motion switch turns
the dynamic movement on and off while
you're working on your presentation. Use
the Colors sliders on the gradient bar to
get the precise tones and blends that
you're looking for.

Sl Al [P

'8 Save background

" Now that you've created your own
custom dynamic background, you'll want
to save it. Go to the background picker,
navigate to the blank page and click the
“+"in the first option. The background is
now saved for later use.

HOW TO Add dynamic backgrounds on your iPad

FAST BIKES

o Using an iPad

If you're using Keynote on an
iPad, dynamic backgrounds work in a
very similar way to Keynote on a Mac. Tap
on the background of a slide, and then
click the brush icon to see the formatting
tools in a pop-up window.

Image rights: Apple Inc.

9 The backgrounds

In the window that appears, tap
on the Background option, and then
select the Dynamic tab as shown.
Choose a background from the picker at
the top; swipe the options right and left
to cycle through them.

How to do anything on your Mac, iPhone & iPad

e

Background Color
Click on the box labelled
Background Color to choose a new main
color for your dynamic background. Click
the color wheel next to it and you can
change its opacity too, using the slider
in the new window.

THINGS WE DID
IN MONACO

¢ Wigtohud (hie Vsbemiuill ¢
gralifying scwiions

- H'_pﬂutqmmmrd

ERXE NN

9- - The other slides

If you wish to use the background

on other slides in your presentation,
simply hold down Shift and select other
slides in the slide picker on the left. The
slides will then automatically be given
the new background.

e Multiple slides

To select every slide, tap the
currently highlighted one and choose
Select All from the contextual menu. You
can then add a dynamic background to
the whole presentation at once instead
of slide by slide.

JAN 2023

95



96

i
i?'-h ik
i H_;‘}
W e

=

A )

3 Create

<

i

-

How GaN chargers work

YOU WILL LEARN
What a GaN charger is, why
it's an improvement on
current chargers and what
they can do for travellers.

THE NEXT
GENERATION
OF CHARGERS
WORK MUCH
SMARTER, AND
WITH GREATER
EFFICIENCY

1=

KEY FACT

GaN chargers generate less
heat than regular models,
and transfer power more
efficiently. This means they
can be built with several
outlets, charging multiple
devices at once, including
notebooks. The future of
mobile device charging
belongs to GaN chargers.

JAN 2023

GaN CHARGERS ARE cool. Not
in the informal statement of
approval sense, but they’re

* quite literally cool. By using
gallium nitride (GaN for short) instead of
silicon for their transformers, GaN
chargers generate less heat when
charging. This means the components can
be packed closer together in the unit,
making them smaller and easier to carry
around. And with less energy being lost to
heat, the power is more efficiently
transferred into the device that you’re
charging. They can also carry a greater
voltage than silicon too. The end result?
Faster charging.

Gallium nitride itself isn’t a new
discovery. It’s been used in blue light-
emitting diodes (LEDs) since the Nineties,
and later provided the breakthrough that
made the first white LEDs possible. It’s
also used for solar cell arrays on satellites,
and the blue lasers used in Blu-ray
players. But it’s the potential of gallium
nitride semiconductors in chargers
and power supply units we’re interested
in here, and in this area, it’s fairly new.

Back in the day, a charger was a very
simple device. It transferred mains power
to a battery—powered device, constantly
charging the battery. Yet as mobile
technology advanced, it was realized that
this was a very poor way of powering up.
Receiving a constant power supply in this

The extra power enables it to charge multiple devices
without being physically larger than a regular charger.

way, even when the battery was full,
caused degradation over time. A degraded
battery holds less power, meaning you got
shorter and shorter use from your mobile
device before it needed charging again.

The next generation of chargers work
much smarter, and with greater
efficiency. A silicon—based chip inside the
device monitors the battery capacity and
notes how full it currently is, adjusting
the power going into the cell accordingly.
A fast charger might fill your battery up to
around 80% full as quickly as possible, but
slows down greatly for the last 20%,
reducing wear and tear on the battery and
prolonging its life.

For the emerging GaN charger generation,
a gallium nitride semiconductor chip
replaces the silicon—-based one. As stated,
GaN chips are more energy efficient than
silicon chips. When a regular charger is
plugged into the mains, it gets warm to
the touch. Not so GaN chargers, which
lose much less energy as heat. This means
heat-dissipating components such as
heatsinks aren’t needed. Passive
components that reduce the flow of
electricity through a circuit are in less
demand too.

With the transistors giving off less heat
you can place them closer together, and
incorporate several outlets into the same
charging device too. This means you can
charge multiple devices at once, with the
charger providing enough power to do so.
And with GaN chargers of around 65W
appearing, they have enough power to
charge a laptop.

This is obviously great news for
holidaymakers and business travellers.
Where before you might need to carry
separate chargers for your MacBook, iPad,
iPhone and Apple Watch, now a single
charger might cover all your equipment.
And that charger might actually be
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> WHAT IS GALLIUM NITRIDE?

Gallium nitride (GaN) is a direct
bandgap semiconductor that
combines gallium (atomic number
31) and nitrogen (atomic number
7). It has a very hard hexagonal
crystal structure, is very stable
and has a wide bandgap. All
semiconductor materials have a
bandgap. an energy range where
no electrons can exist. The wider
the bandgap, the higher voltages
it can sustain, and higher
temperatures it can tolerate.
Gallium nitride's bandgap is 3.4
eV, while silicon’s is only 112 eV.
As well as a wide bandgap,
a GaN transformer has a higher
breakdown strength, better
thermal conductivity, a faster
switching speed and lower on-

F

]
L]
]
]
]
i
|
]
L]
L]
]
1

conducts electrons more than
1,000 times more efficiently
than silicon.

Gallium nitride is the
technology that makes possible
high-resolution color screens
found in flat-screen televisions,
mobile phones, tablets, notebook

Gallium nitride has a hard crystalline
structure, and conducts electrons

resistance, making it ideal for
power-based devices. According
to EPC Corporation, GaN

computers and monitors. It's also
used to generate the blue lasers
used in Blu-ray players.

more efficiently than silicon.

Source: GaN Wurtzite crystal
structure, Wikipedia

smaller and lighter than the ones you’re
used to as well. It’s also likely to last
longer before failing. With less heat
generated by the charging process there’s
less strain on the charger, meaning it’s
less susceptible to wear and tear.

But is there a drawback in using gallium
nitride instead of silicon for charging
products? At the moment, there is: cost. A
gallium nitride semiconductor as used in
GaN chargers are more expensive than
silicon semiconductors. As a result, a
gallium nitride—based charger
is considerably more expensive than a
silicon-based model. Yet this isn’t likely
to be the case for long. As GaN chargers
become more popular, gallium nitride
semiconductors are likely to come down
in price due to economies of scale. Better
still, as GaN chargers produce much less
heat than silicon chargers, they need
fewer components such as heatsinks,
passive inductive and capacitive circuit
elements and more. This, of course, will
bring down the price. Semiconductor

manufacturers GaN Systems predict an
eventual saving of 10-20% for products
that use gallium nitride semiconductors.

GOING, GOING, GAN
GaN chargers are not yet widespread, but
you can already buy one if you wish.
Third-party manufacturer Belkin, for
example, has a powerful 108W four—port
GaN charger for just under $S90. With two
USB-C and two USB-A ports, you’ll be
able to power a laptop and three
additional devices. Amazon has a
competitively priced two—port 65W
charger for a little under $20. This charger
has a 45W USB-C port and an 18W USB-A
port; just the thing for laptops, tablets
and phones. For a little under S40, MINIX
has a 66W three-port GaN charger (two
USB-C and one USB-A), which comes
with UK, US and European plugs, so it’s
ideal for travellers.

With gallium nitride chargers, the
future for mobile devices looks very cool
indeed. IAN OSBORNE

KEY FACT

According to several
sources, Apple is working
on GaN chargers, for
possible release in late
2022. Several third-party
manufacturers make GaN
chargers that are faster,
smaller and simply better
than the ones Apple
supplies itself, so

a move to gallium nitride
chargers would make
sense. It would also allow
Apple to streamline its
charger line-up, with a
single charger covering a
wider range of products.
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MOVE TO
NEW DEVIC

Whether it's Mac, iPhone, iPad or
& Watch, we'll show you how to
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migrate with ease

Take better photos
on your iPhone

Our in-depth guide to capturing
stunning shots - and editing them
to perfection - on your iPhone

watchOS 9
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Make the most of your Apple Watch —
this in-depth guide will show you how

..and much morel
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PAPER LOVES TREES

U.S. forests, which provide wood for making paper,
paper-based packaging and many other products,
have been growing by over 1,200 NFL football fields every day!

Discover the story of paper
www.lovepaperna.org

Source: According fo the UN Food and Agriculture Orgonization’s 2020 Global Forest Resources Assessment,
U.5. forest area expanded by an average of 605,000 acres per year between 1990 and 2020
An NFL football field is 1.32 ocres in size.
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